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Preface

Welcome to the Oracle Customer Relationship Management, Release 11i, suite of 
applications.

This Implementation Guide provides information and instructions to help you 
effectively implement Oracle eMail Center.

This preface explains how the Implementation Guide is organized and introduces 
other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

■ Anyone implementing Oracle eMail Center

This guide assumes you have the following prerequisites:

■ Understanding of the company business processes

■ Knowledge of products and services as defined by your marketing policies

■ Basic understanding of Oracle

Structure
This guide contains the following sections:

■ Section 1.1, "eMail Center Overview"

■ Section 1.2, "Application Architecture"

■ Section 1.3, "eMail Center Processing"
ix



■ Section 1.4, "Desktop Processing"

■ Section 1.5, "Planning the Implementation"

■ Section 1.6, "Integration Dependencies"

■ Section 1.7, "Installation"

■ Section 1.8, "Implementation"

■ Section 1.9, "Troubleshooting"

■ Section 1.10, "Abbreviations"

■ Section 1.11, "Glossary"

■ Section 1.12, "Related Documentation and Resources"

Related Documents
For more information, see the following manuals:

■ Oracle Email Server Installation and Configuration Guide

■ Oracle Email Server Implementation Guide

Documentation Accessibility
Oracle’s goal is to make our products, services, and supporting documentation accessible to the 
disabled community with good usability. To that end, our documentation includes features that make 
information available to users of assistive technology. This documentation is available in HTML 
format, and contains markup to facilitate access by the disabled community. Standards will continue 
to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to 
address technical obstacles so that our documentation can be accessible to all of our customers. For 
additional information, visit the Oracle Accessibility Program web site at 
http://www.oracle.com/accessibility/.
x
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Implementing Oracle eMail Center

This document contains the following sections:

■ Section 1.1, "eMail Center Overview"

■ Section 1.2, "Application Architecture"

■ Section 1.3, "eMail Center Processing"

■ Section 1.4, "Desktop Processing"

■ Section 1.5, "Planning the Implementation"

■ Section 1.6, "Integration Dependencies"

■ Section 1.7, "Installation"

■ Section 1.8, "Implementation"

■ Section 1.9, "Troubleshooting"

■ Section 1.10, "Abbreviations"

■ Section 1.11, "Glossary"

■ Section 1.12, "Related Documentation and Resources"

1.1 eMail Center Overview
Oracle eMail Center is a complete solution for managing both inbound and 
outbound email interactions with customers, partners, suppliers, employees and 
other entities that interact with an organization.

Oracle eMail Center invokes appropriate, customizable processes that are targeted 
to handle different types of inbound email interactions. Every inbound email is 
analyzed using the interMedia Text (iMT) component of the Oracle 8i database to 
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Application Architecture
determine the intent of the message based on its linguistic properties. iMT provides 
a string of keywords or themes which are utilized by the classification engine to 
classify or categorize the email. eMail Center also uses the same set of keywords or 
themes to search the Knowledge Base for related documents. The email is then 
routed to a queue which can be accessed by a pre-defined group of agents, based on 
user-defined rules which could use data extracted from the email header, email 
classification (or category) and system variables such as time of day, and so on. 

When the first available agent requests the next email interaction from the queue, 
the email is assigned to that agent and can no longer be viewed by other agents who 
are handling that account (or queue). Oracle eMail Center provides an agent with 
tools and capabilities to maximize their productivity and effectiveness. The Agent 
User Interface (UI) displays the list of classifications (or categories) pertaining to 
that email sorted by their associated confidence scores (percent probability) and also 
provides the agent with a list of fully formed suggested responses for each of the 
above classifications, which are also sorted by their respective confidence scores. 

In this way, the agent can respond to multi-issue emails by using the point-and-click 
action of a mouse button. Agents can also access the knowledge base repositories 
and attach documents to the email response. Additionally, the agents can browse 
through the folders on their desktop and select documents to be attached.

In addition to managing inbound email interactions, eMail Center provides 
capabilities to initiate and manage outbound interactions. An agent can be provided 
with a set of templates or style sheets for composing outbound emails which are not 
in response to an incoming email. The agent can insert text into the email by 
browsing through the documents available in the Knowledge Base and selecting 
them to be inserted into the email by the click of a mouse button. A full featured 
editor enables the agent to customize the responses as well as outbound email 
messages. You can leverage the power of Oracle eMail Center to analyze incoming 
emails and extract data, and its integration with other eBusiness applications.

Oracle eMail Center is a comprehensive email interaction management solution for 
service, marketing and proactive relationship management that ultimately 
translates to a better customer experience.

1.2 Application Architecture
Oracle eMail Center is comprised of the following main components.
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Application Architecture
eMail Center Agent User Interface
A Java Server Pages (JSP) based application that runs on the agent desktop in an 
Internet browser. The supported browser is Microsoft Internet Explorer 5.0 and 
higher. It utilizes two Java Applets, an editor applet that allows the user to compose 
messages and select the font, color, formatting, etc., and it also allows importing of 
images (both .gif and .jpg files) and the second is a hidden applet, which maintains 
a connection with the Universal Work Queue (UWQ). This applet allows the 
exchange of information between eMC Agent UI and UWQ.

eMail Center System Administration Interface
A Java Server Page (JSP) based graphical user interface allows defining and viewing 
of various eMail Center components. An administrator can define email accounts, 
IMAP servers, SMTP servers and database links.

eMail Center Operations Manager Interface
A Java Server Page (JSP) based graphical user interface allows authorized 
interaction center domain experts (operations managers) to configure operational 
rules or business practices for eMail Center. The Operations Manager can create and 
fine tune email classifications and themes from this interface.

eMail Center Server
Is a multi-threaded Java based server that delivers information derived from an 
email message to the Oracle Telephony Manager server for routing and delivery to 
the appropriate agents.

eMail Center Workflow
This is the workflow based engine that process all inbound email messages. It can 
be customized to process emails based on different business needs. 

Oracle Email Server (OES)
This is the mail server that receives and sends the emails for eMail Center.

1.2.1 Other Modules, Servers and Components
Oracle eMail Center also uses the following other modules, servers and 
components.
Implementing Oracle eMail Center 1-3
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CRM Modules
eMail Center uses several features of the CRM products, such as the Marketing 
Encyclopedia System (MES), Universal Work Queue and Interaction History.

Oracle Telephony Manager Server
Oracle Telephony Manager (OTM) holds the state of all the agents and maintains 
the distribution queues for all interaction center media. OTM drives the routing 
server to determine which agents are to receive email. OTM receives the email from 
eMail Center and sends it to the routing server. The output of the routing server is a 
list of agents qualified to handle the interaction. Based on this list, OTM distributes 
email. “Distribute” in this case means that it puts the email into the agent queues 
that the routing engine identified.

This process occurs once for every new email. Although many agents might see the 
email in their queue, only one agent will service the interaction. Upon delivering 
the email to an agent, OTM removes it from all other agent queues. When an agent 
selects the email from the queue, OTM fires an event to the agent desktop. When 
this happens, the agent might see a screen pop with a subset of the information 
contained in the email interaction.

1.2.2 Application Configuration
 These figures show a typical and an alternate configuration of the various servers.
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eMail Center Processing
1.3 eMail Center Processing
When an incoming email arrives at Oracle Email Server (OES) component of the 
Oracle eMail Center, OES queues the email for the workflow to process and make 
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eMail Center Processing
available to an agent. The information from the email header and readable 
attachments are then extracted from the email and is concatenated to the body of 
the email. 

The data from the incoming email (along with the header and attachment data) is 
then analyzed by the interMedia Text (iMT), which then provides a string or 
signature of keywords or themes. The signature is then used by the classification 
engine to categorize or classify the email and also scan the knowledge base 
repository for related response documents. The meta-data regarding the email and 
top (based on the calculated confidence score or percent probability) classifications 
and top suggested response documents is then made available to Oracle Telephony 
Manager (OTM) through the Oracle eMail Center server.

The routing engine then uses the meta-data and applies user-defined rules to route 
the email to an account or queue. The OTM server then provides the queue 
information to the Universal Work Queue (UWQ), which displays the totals for 
every account or queue to which an agent is assigned.

When an agent selects a particular email queue in the UWQ and request the next 
interaction, the UWQ informs the OTM server regarding the agents request, which 
in turn requests the Oracle Email Server to assign the next email in the queue to that 
particular agent. Oracle Email Server transports the email to the agent’s personal 
folder.

At the agents desktop, the business application is launched displaying the customer 
contact information. The eMail Center Agent UI is also launched with the contents 
of the fetched email displayed for the agent to preview. The agent can then perform 
any of the operations discussed in detail in the following section titled “Desktop 
Processing.”

Finally, the agent is required to end the current interaction to be able to fetch the 
next email (or any other media supported in the interaction center) interaction.
Implementing Oracle eMail Center 1-7



eMail Center Processing
1. Inbound email arrives at the SMTP Server.

2. OES attempts to place the email ID into AQ1.

■ OES (Oracle Email Server) lets eMC know that a new email has arrived by 
executing a server-side rule that places the email ID in AQ1.

■ AQ (Advanced Queuing) is a feature of the Oracle 8i database that provides 
asynchronous notification between components. In this case, AQ1 items are 
picked up by the unstructured workflow that is initiated by the Concurrent 
Manager.

3. OES delivers the incoming message to the appropriate account inbox folder if 
the email ID was successfully put in to AQ1.
1-8 Oracle eMail Center Implementation Guide
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■ If the email ID could not be put in to AQ1, the incoming message 
is delivered to the RETRY folder of the appropriate account.

■ Later (controlled by the administrator), eMC processes items in the retry 
folder and attempts to put the email IDs of these items into AQ1.

4. Concurrent Manager launches the unstructured email processing workflow.

■ The unstructured email processing workflow (WF) picks up the next email ID 
from AQ1 and begins processing the associated email.

■ The appropriate path in the unstructured processing WF is executed, based on 
the OES account to which the email was delivered.

■ The account is a business account, such as “support”, “service”, “sales”, or 
“marketing”. Later in this diagram, the email message is moved to the account 
of an agent associated with the business account.

■ (go to step 5A)

(5A) Unstructured email processing continues.

■ Execute any user defined business rules / procedures to analyze the email.

■ The iMT based automated intent analysis is performed to generate suggested 
classifications and suggested responses for the email being processed.

■ Note: The ability to send an automated response if the confidence threshold is 
exceeded is only available as a local customization

(5B) Unstructured email manual (agent) response.

■ Additional implementation specific unstructured email processing (if any) is 
done and the email ID, along with other metadata, is delivered to AQ2.

■ AQ2 is another advanced queuing notification, similar to AQ1.

■ AQ2 is an asynchronous notification between the unstructured workflow 
and the eMC server.

5. eMC Server fetches the metadata from AQ2.

6. eMC Server delivers the metadata to Oracle Telephony Manager.

7. Oracle Telephony Manager sends the metadata to and gets back route 
destinations from the Routing Server.

■ The Routing Server evaluates implementation specific static or dynamic routing 
rules to determine route destinations for the email message.
Implementing Oracle eMail Center 1-9
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■ The Routing Server specifies which individual agents can receive the email    
message. (The individual agents are the route destinations).

■ If an agent group qualifies for the email message, the Routing Server identifies 
all the agents in the group as route destinations.

■ The route destination information is sent to Oracle Telephony Manager.

8. Oracle Telephony Manager adds the email item to the personal queue of each 
agent specified by the Routing Server.

■ Oracle Telephony Manager keeps track of the status of all the agent queues. It 
manages the agent queues.

9. In the agent work area, the agent requests the next media item (email) from the 
UWQ GUI.

■ Agent selects the appropriate email account / campaign in UWQ and clicks on 
the “Get Work” button in the UWQ GUI.

■ The UWQ GUI form invokes the UWQ Client bean.

10. UWQ Client sends the “Get Work” request to UWQ Server.

■ It specifies which agent is making the request.

■ If specifies that the request is for the next email item.

11. UWQ Server passes the “Get Work” request to the Oracle Telephony Manager 
Server.

12. (13A) Oracle Telephony Manager passes the “Get Work” request to the eMC 
Server.

(13A1) The eMC Server makes a call to OES to move the appropriate email message 
from the account inbox to the agent’s email folder inbox.

(13A2) OES executes the request.

■ OES moves the email message content from the account Inbox to the agent’s 
folder.

Note: Step 9 is the end of the email driven process. That is, the 
arrival of a new email message triggers the processing described up 
to this point.
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(13B) Oracle Telephony Manager passes the email item metadata to the UWQ 
Server. The metadata contains:

■ Media item type (email, telephony, …)

■ Email ID (MSG_ID)

■ Sender’s email address

■ Other key value pairs

13. UWQ Server passes the metadata to the UWQ Client.

14. (15A) UWQ Client pops the business application and sends it the metadata so 
that fields in the business application screen are filled appropriately.

■ In most cases, the sender’s email address from the incoming message is used to
identify the customer and populate the business application form with the 
appropriate customer information

(15B) UWQ Client pops the eMC Agent UI (eMC AG) to the “Preview” screen. The 
actual message content is retrieved from agent’s folder in the OES Message Store 
and displayed in the eMC AG

■ The agent can read the message and choose to:

■ Respond to the message

■ Cancel immediate processing of the message (put it off until later)

■ Reroute the email

■ Forward the email

■ Transfer the email

15. On the Agent UI, eMC AG displays customer data, made available from the 
business application by the UWQ Client.

■ eMC AG displays the customer data in its Customer Profile area.

■ TeleService Contact Center is an example of a business application.

■ UWQ Client delivers the screen pop to the business application form being 
displayed on the Agent UI (see 15A).

■ The business application form sends appropriate data to eMC AG for display.

Note: Only the Respond option is used as an example.
Implementing Oracle eMail Center 1-11
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16. The agent selects the ‘Respond’ option in the eMC AG ‘Preview’ screen and the 
‘Response screen is displayed.

■ Other metadata for the message retrieved from the database and displayed in 
the various eMC AG screens includes:

■ Suggested classifications

■ Suggested responses

■ Marked up message information

17. JSP / JTF components interpret actions taken in the eMC Agent UI and makes 
the appropriate API calls in response to these requests to perform the desired 
actions.

18. Create and send the agent generated response.

■ The agent constructs the response in the editor by typing in the response and / 
or picking up suggested responses or response documents and attachments 
from the knowledge base or file system.

■ The response is composed and formatted by the JSP / JTF servlets on the web 
server.

19. The outbound email submitted is sent to the SMTP server process running on 
the host machine.

1.4 Desktop Processing
The eMail Center Agent UI is provides an agent with the capability and 
functionality to respond to incoming emails as well as compose outgoing emails 
with sheer point-click action of the mouse button, thereby increasing the 
productivity of the agent. Below we discuss the various screens available to the 
agent while processing an incoming email or generating an outgoing email and the 
functionality provided in each screen.
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1.4.0.1 My Messages Screen
In this screen all folders pertaining to that agent are displayed. For every account 
that the agent handles an inbox is created along with a Draft folder. The agents can 
add/delete other personal folders and move messages within the folders using the 
self-explanatory buttons provided on this screen. Only emails fetched by the agent 
which have yet to be responded to are displayed in the Inbox. Once an agent 
responds to an email, the email is moved out of the agents folder into a universal 
“Resolved” folder for that account. If the agent decides to delete an email, then the 
email is moved from the agents folder to the universal “Delete” folder for that 
account. The agent can preview an email by clicking on the subject line of the email 
or compose an outbound email by clicking on the Compose button. The agent is 
also provided an option to fetch multiple emails from this screen, rather than attend 
to single interactions. However the agent has to end an interaction if they are 
currently attending to one prior to fetching future interactions.
Implementing Oracle eMail Center 1-13
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1.4.0.2 Preview Screen
When the agent selects the next email interaction from the Universal Work Queue, 
the contents of the email is displayed in the Preview screen. In the Preview screen, 
the agent is provided with the following options:

■ Respond

Agent will select this option if they wish to respond to the incoming email 
inquiry.

■ Transfer

If the agent feels that they are not the expert on the subject that email is 
referring to, they can transfer the email to another agent, who is known to be 
the expert on that particular subject.

■ Forward

Forward option enables the agent to forward the email to anybody inside the 
organization (external to the interaction center) or outside the organization.

■ Reroute

Reroute directs the email back to the routing server to route it again. This is 
primarily useful if the agent is not an expert on the subject and is not aware of 
which agent has the expertise.

■ Print

Prints the email currently displayed in the preview screen.

■ Delete

Enables the agent to delete the email they are currently reviewing. The eMail 
Center does not physically delete the email but stores the email in a “Delete” 
folder for that email account.

■ Cancel

If the agent does not wish to take any action at this time, then they can cancel 
the preview operation without taking any action.

1.4.0.3 Respond Screen
This screen provides the agent with the functionality to respond to incoming emails 
by selecting top classifications and the top responses for each classification and 
customizing the response by using the full featured editor. The agent also has the 
option of attaching or inserting documents from the Knowledge Base or their 
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personal hard drive. The top classifications or categories displayed in the bin on the 
left hand side. When the agent clicks on the classification name, the list of top 
suggested responses for that classification is displayed in a separate pop-up 
window. The agent can then view the contents of any of the suggested responses by 
clicking on the response document title. The customer name will be automatically 
merged into the response document as a result of the integration of eMail Center 
with the business application. The agent can then insert the document into the 
response or attach it to the response. In the response screen, the agent has the 
following options:

■ Send

When the agent has composed a response to the incoming email, the agent can 
send the response back to the customer by clicking the Send button.

■ Cooperate

The Cooperate functionality enables the agent to collaborate with another agent 
on a multi-issue email. The email response drafted by the first agent is then 
forwarded to the second agent who adds to the response and sends the 
response to the customer.

■ Attach

This feature allows agents to add documents from their personal hard drives to 
responses.

■ Save

Using this option, agents can save the draft of the response if they wish to 
complete it later.

1.4.0.4 Compose Screen
The agent can compose an outgoing email (that is not a reply to an incoming email) 
to a customer by clicking on “Compose” from the agent’s messages screen. The 
Compose screen provides the agents with templates or style sheets that they can use 
as building blocks for composing emails. The agent can click on the Knowledge 
Base tab to view documents stored in the repository and to add/insert to the same 
response.

1.4.0.5 Knowledge Base Screen
When an agent clicks on the Knowledge Base tab, the documents stored within the 
Marketing Encyclopedia system are displayed. The agent can either search for a 
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document or flow through the navigation tree to view a particular document. An 
agent is able to insert the contents of a document into the response or attach it.

1.4.0.6 History Screen
The History screen enables an agent to view the contents of an archived email. 
However, the agent needs to know the message ID of the archived email.

1.5 Planning the Implementation
Implementing Oracle eMail Center is a complex process that requires knowledge of 
a variety of technologies and processes. Persons implementing Oracle eMail Center 
should have a working knowledge of Oracle Forms, HTML, Java, and the 
installation platform (Windows NT or Unix), in addition to an understanding of the 
operational requirements of an interaction center.

This topic group contains an implementation planning questionnaire that will help 
you determine and collect information you will need during the implementation 
process.

1.5.1 The Implementation Process
The following diagram depicts the implementation process for eMail Center:

Note: In the current release, documents that contain embedded 
image files can ONLY be inserted into the response, they CANNOT 
be attached to it. 
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1.5.2 Implementation Planning Questionnaire
The following questions provide a high level overview of the information necessary 
to successfully implement Oracle eMail Center. This is information that should be 
decided upon prior to beginning the implementation process.

Use the following questionnaire to gather information crucial to the implementation 
process:
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1. What email addresses does the business want to set up to receive email?

You will need to define the corresponding email accounts on OES to which 
inbound email will be directed. Examples could be: support@company.com, 
info@company.com, promotions@company.com, sales@company.com, etc.

2. For each email account to be defined, which agents will be processing 
interactions?

Note: An agent may be defined for multiple accounts, e.g., if an agent needs to 
work on email interactions sent to the ‘support’ account as well as those sent to 
the ‘info’ account.

3. How will agents be grouped for each account?

Is it sufficient to define only one group for all the agents assigned to a particular 
account, or does it make sense to divide the agents into groups?

It would make sense to define multiple agent groups for a particular account if 
there will be different agents who focus on working on certain types of issues / 
classifications for the account, so that routing rules can be set up appropriately.

4. For each account, what’s the set of classifications that need to be defined?

These classifications are essentially labels for the buckets into which the 
customer wants to sort incoming emails for a particular account. Classifications 
can be used to route individual emails to agents as well as select the appropriate 
responses from the knowledge base. The subject matter for each classification 
should be mutually exclusive and collectively exhaustive for emails expected to 
be received in that account. 

5. What are good sample messages for each classification?

■ Does the customer already have sample data?

■ Do you need to create samples for classifications?

■ Do the samples completely represent the different subject matter 
anticipated in emails belonging to the classification?

Note: Setting up multiple groups for a given account does not 
mean that you cannot route a given interaction to multiple groups. 
Defining multiple groups provides additional granularity for 
routing purposes.
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6. What are good sample responses for each classification?

■ Does the customer already have sample data?

■ Do you need to create samples for classifications?

■ Do the samples completely represent the different types of responses for the 
classification?

 Ideally, there should be at least one sample response for each sample message. 
As is the case with sample messages, the quality of the sample responses 
directly impacts the effectiveness of the response selection functionality and 
should only contain text that is directly relevant to the response subject matter.

7. What documents need to be uploaded to the knowledge bases? 

8. What static routing rules need to be defined?

What should be the destination agents / agent groups for each static route?

9. What dynamic routing procedures / workflows need to be developed?

What are the implementation details for creating the stored procedures / 
workflows?

10. What keywords or key phrases in the headers or contents of a message indicate 
which eMC account a message belongs to?

For example, a message with the key phrase ‘service request’ belongs in the 
‘support’ account, and if it was sent to the ‘info@company.com’ account it 
should be redirected to ‘support@company.com’.

11. What are the business requirements for processing unstructured emails?

■ What are the rules for determining when to send an auto-acknowledgement 
and selecting the response for the auto-acknowledgement?

Note: The quality of the sample messages directly impacts the 
effectiveness of the classification functionality. Sample messages 
should only contain text that is directly relevant to the subject 
matter for that classification (the text can be regular sentences as 
opposed to a list of keywords, but should not contain text such as 
‘Thank you in advance for your prompt attention to this matter,’ or 
other extraneous text).
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■ What information from the CRM DB needs to be extracted to make 
processing decisions for an email message?

■ What information should the system look for in the incoming message to 
use in rules processing?

■ And so on...

12. How should bounced messages and other responses to tagged emails be 
handled?

■ Responses routed directly to the agent who sent out the message, or routed 
according to the routing server rules?

13. Notify sending application on message bounce?

14. What are the default outbound email header values for each account?

From address, reply-to address, etc.

1.6 Integration Dependencies
This topic group contains a list of the core products with which Oracle eMail Center 
integrates and a brief description or each core product.

1.6.1 Oracle Email Server (OES)
Oracle Email Server is the core email system. The native email functionality is 
supported by this system. Oracle Email Server has both PL/SQL and IMAP 
interfaces and is bundled with the Sendmail implementation of SMTP service.

The topics in this section describe its important sub-components.

1.6.1.1 IMAP server
Oracle Email Server implements the server section of the IMAP protocol. The server 
is mainly used by the IMAP implementation of JMA (middle tier) to access emails 
stored in the Message Store.

1.6.1.2 Message Store
The Message Store resides in an Oracle database (8.1.6), and it is a collection of 
database tables and stored procedures that implement the various email specific 
operations. Email accounts including folders, all incoming emails, and all outgoing 
emails are stored here.
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1.6.1.3 SMTP Server
Currently Oracle Email Server is bundled with the Sendmail’s implementation of 
the SMTP protocol. Various options like third party spam and virus checks can be 
added to make a more robust system.

1.6.1.4 OES PL/SQL APIs
The Oracle Email Server PL/SQL APIs extend the normal email functionality to 
implement rule based notifications, account maintenance, and interMedia Text 
(iMT) processing of incoming email messages. This additional functionality results 
in a close integration with the Oracle Email Server product.

Known Limitations:
■ Oracle eMail Center is tightly integrated with this product. Other Email 

Services, existing or new, must integrate with this product.

■ Spam and Virus check features are currently missing.

■ Email encryption/decryption features are missing in the Oracle Email Server 
release 5.1.x.

■ Oracle interMedia Text’s linguistic processing currently work only on English 
text. Other languages are being supported in the future releases.

Platform Dependencies:
Oracle Email Server and its components are ported to most major platforms.

Configuration Options:
Oracle eMail Center can integrate to multiple instances of Oracle Email Server. In 
some cases there will be multiple instances of Oracle Email Server Message store, 
which share a common IMAP server and SMTP components.

1.6.2 Oracle interMediaText (iMT)
Oracle interMedia Text is a text/linguistic-processing module bundled as a 
component of Oracle 8.x database. It is mainly used to determine the intent of each 
incoming email message.

Known Limitations
■ Oracle interMedia Text’s linguistic processing currently work only on English 

text. Other languages are being supported in the future releases.
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■ Only bundled with Oracle 8 and higher versions. Not available on earlier 
versions.

Platform Dependencies
Ported to most major platforms.

Configuration Options
You can customize the linguistic processing module by modifying the theme and 
iMT Knowledge Base sections. This focuses the linguistic processor to look for more 
relevant information and enables you to fine-tune email processing.

1.6.3 Oracle Telephony Manager (OTM)
The Oracle Telephony Manager maintains the agent distribution queues and agent 
states for any Interaction Center. It also provides access to a common routing 
engine. OTM is media independent and can route all types of interactions (email, 
telephony, faxes, web calls) to the interaction center agents.

Known Limitations
Only one OTM server can exist per Interaction Center.

Platform Dependencies
A Java Server; Runs on Solaris and NT platforms.

Configuration Options
There is a 1:1 relationship between an OTM and an the eMC Server; however, the 
rest of the eMail Center modules are shared.

1.6.4 Routing Server
The Routing Server determines which agent(s)/agent groups get a new interaction. 
The routing can be skill and/or rule based. The routes are defined for various 
classifications and parameters.

Platform Dependencies
A Java Server; Runs on Solaris and NT platforms.
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1.6.5 Work Blending
The Work Blending server determines the type (email, phone call, fax, etc.) of 
interaction an agent should service next. To make this determination, Work 
Blending obtains real time information about the agent from UWQ.

1.6.6 Universal Work Queue
UWQ Client and Server code work in unison to do the following:

1. Relay information between OTM and the Forms Application.

2. Capture certain information for statistical purposes.

3. Capture certain information for work blending purposes.

UWQ also works in conjunction with Work Blending to determine what type of 
interaction the agent should service next.

Platform Dependencies
■ A Java Server; Runs on Solaris and NT platforms.

1.6.7 Interaction History (IH)
The Interaction History maintains all interaction life-cycle segments, i.e. accounts 
for the entire time duration beginning at the moment an Interaction (fax, phone call, 
email.) is registered in the system to the instant it is resolved. This is a cumulative 
record of all interactions passing through the system. It also records information 
about various agents who handled the interaction in the recorded time duration.

1.6.8 Forms Business Application
This can be any Oracle CRM Forms application (Oracle Service, Oracle TeleSales, 
Customer Care). These forms applications embed the UWQ client, enabling them to 
work with the Oracle eMail Center Agent UI. This is done via Java socket 
communication between the UWQ client and the eMC Agent UI. The business 
applications contain the necessary profiles and business intelligence.

1.6.9 Knowledge Management Systems (KMS)
At present, the Knowledge Management system consists of SMS and MES. All KMS 
interactions are channeled through the SMS system which exposes a single set of 
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APIs hiding the complexity of the various sub-systems. Both PL/SQL and Java APIs 
exist to enable interMedia based queries and retrievals.

Both MES and SMS are knowledge bases. eMail Center uses MES to store eMC 
specific documents. SMS is currently optional for eMail Center.

1.6.9.1 Solution Management System (SMS)
A repository of problem, diagnosis, related symptoms and their solutions.

1.6.9.2 Marketing Encyclopedia Systems (MES/KB)
MES is also known as the Knowledge Base (KB). It is a repository of various 
documents, URL, images and such. MES is partitioned into various application 
spaces, each application (e.g Tele-Sales, Oracle eMC, etc.) can store documents, 
URLs, images and such in its own private space in this system. Various PL/SQL 
and Java APIs and a JSP UI exists to create/upload, list, categorize and order these 
entities.

Platform Dependencies
■ A database module; Oracle 8.x ported to most platforms.

1.6.10 Concurrent Manager
Concurrent Manager is a component of Oracle Application Object Library. It is 
responsible for scheduling and running various concurrent programs submitted by 
the user. It uses Distributed Concurrent Processing and can simultaneously run 
concurrent requests on several different server machines or CPUs. Oracle eMail 
Center makes use of this facility to schedule and run various email processing 
modules.

Platform Dependencies
■ A database module; Oracle 8.x ported to most platforms.

1.7 Installation
 This topic group covers the following topics:

■ Installation by Rapid Install

■ Post-installation steps
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1.7.1 The Auto-Installation Process
This topic provides a high level overview of the auto-installer (Rapid Install) 
process. This process installs the schema and core functionality (Foundation 
Components) for Oracle applications. There are five steps in the process, as well as 
some finishing steps that need to be performed to successfully complete the 
installation process.

Steps
1. Choose the desired install environment (production, test, or demo).

2. Select the products to install.

3. Select the NLS settings.

4. Select the location of the top-level directories.

5. Select the name of the configuration file.

6. Complete the finishing steps necessary for the products you selected to install.

References
For more detailed information on the Rapid Install process, please refer to the How 
Rapid Install Works topic group in the Installation Overview section, and the 
Running Rapid Install topic group in the Starting Your Installation section of the 
Oracle Applications Installing Oracle Applications documentation.

1.7.2 Post-Installation Steps
Two post-installation procedures are necessary for the eMail Center server side. The 
first procedure consists of installing and configuring the Email Server. The second 
procedure involves installing and configuring the eMC Server. For the second 
process, you will need the Oracle Call Center Applications Setup CD.

Installing and Configuring Oracle Email Server (OES)

Installing and Configuring Oracle eMail Center Server (eMC)

Note: Make sure Oracle Email server and interMedia Text are 
certified on your operating system platform before starting the 
installation. Oracle eMail Center requires these Oracle products to 
function.
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1.7.2.1 Installing and Configuring Oracle Email Server (OES)
Use this procedure to install and configure Oracle Email Server.

Prerequisites
Before configuring the Email Server, you should complete the initial Rapid Install 
process. The Oracle Email Server documentation provides detailed instructions on 
installing Email Server with Rapid Install.

Steps
1. Install Oracle Email Server (OES) 5.1 (patchset 3) on the same or on a separate 

instance as the Oracle Applications Instance. Follow the instructions provided 
in the Oracle Email Server Installation Guide (Installing Oracle Email Server 
section). Oracle Email Server was formerly known as Oracle Internet Messaging 
(IM).

In the post-install Email Server configuration, select NO for LDAP install. For 
more information on this step, refer to the Oracle Email Server Installation Guide 
(Configuring Oracle Email Server section).

Once the installation process is complete, you can configure the Oracle Email 
Server instance to talk with the Oracle Applications Instance.

2. Connect to the Oracle Email Server database instance with the OO user and 
password. Grant privilege on IM_IMT_EXTN to oraoffice.

3. Create a sqlnet tnsnames entry on the Oracle Email Server machine to point to 
the Oracle Applications Instance. (If installed on an instance separate from 
Oracle Applications Instance).

4. Create a Database Link to the CRM instance from the Oracle Email Server 
instance. You need the following:

■  Password for the Oracle Applications APPS schema.

■  Password for the Oracle Email Server OO schema.

Note: The default configuration is single instance. Single instance 
implies that Oracle Applications data and Oracle Email Server data 
reside in the same database.
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Use SQLPLUS to login to Oracle Email Server as user OO (using the OO 
password entered during Oracle Email Server installation) and use the 
following to create the database link:

CREATE DATABASE LINK <link name> CONNECT TO <APPS 
username> IDENTIFIED BY <APPS password> USING <tns / service 
name>;

1.7.3 Installing and Configuring Interaction Center Servers
Use the following procedures to install and configure interaction center servers. 
Email Center will not work without these servers installed, configured and running.

To install and implement the Interaction Center servers that are required to 
implement eMail Center, read the following documentation and follow the specified 
installation and implementation procedures.

Additional Required Documentation
Install the interaction center servers by reading Oracle Call Center Application 
Setup Guide, “Installing Call Center Applications Setup Components.”

Implement the interaction center servers by reading the Oracle Telephony Manager 
Implementation Guide, “Defining an Oracle Interaction Center Server Group.”

Basic Universal Work Queue setup is done with the other interaction server setup in 
the previous procedure. For additional questions or troubleshooting on UWQ, refer 
to the Oracle Universal Work Queue Implementation Guide.

Note: The name of the above mentioned database link <link 
name> is used later to configure other eMC components.
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1.7.3.1 Installing and Configuring eMail Center Server (eMC)

Overview
eMC Server is installed as part of the Call Center Applications installation process.

Prerequisites
Before you can create an eMC Server, you must create a Server Group for the eMC 
Server.

Perform the following steps to create a server group:

1. Open the Server Administration module from the Front Office Navigator, 
the Call Center Administration module, or the Routing Server 
Administration module.

The Server Locator Window opens at the Server Group tab screen.

2. In the Server Group Registration area, enter the server Group Name, 
Location, and Description.

3. From the File menu, choose Save.

Steps
1. From the Forms application login screen, login using the default system 

administrator user name and password.

2. From the list of application responsibilities, select Call Center Server 
Administration.

Note: Oracle eMail Center follows the Oracle standard for User 
Interfaces and the following field colors indicate:

Yellow - required field

White - optional field

Grey - read only field

Light blue - query mode

Note: The server group you create here will be referenced in the 
Create Account screen as an Interaction Center.
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The Call Center Server Administration module appears.

3. From the Call Center Server Administration module, double-click UWQ Server 
Locator (if it doesn’t open automatically).

The Server Locator screen appears.

4. From the Server Locator screen, click the Server tab.

5. In the Server Registration area, type data for the following fields:

■ Server Name

■ Server Location

■ Type Name - select iCenter Server from the drop-down list, click OK

■ Member Group Name - select the server group you want this server to 
belong to, click OK

■ Using Group Name - select the using group ID from the drop-down list, 
click OK This identifies other groups that have permission to use this 
server.

■ User Address - optional field, enter information if you wish

■ Description - optional field, enter information if you wish

■ Server Parameter - not required for configuring eMC Server

■ Value - not required for configuring eMC Server

6. From the File menu, click Save.

References
For detailed information on installing eMC Server, please refer to the Oracle Call 
Center Applications Setup documentation.

Refer to the Oracle Telephony Manager Concepts and Procedures documentation for 
detailed information on creating a server group.

Note: DNS Name and IP Address will be automatically assigned 
after the eMC Server is run for the first time.
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1.8 Implementation
This topic provides a high level overview of the implementation process. This 
section is designed to furnish you with an overall idea of the order in which the 
implementation of Oracle eMail Center occurs. Each of the steps will be expanded 
upon in individual topics.

Prerequisites
The installation process must be completed before you can begin implementing 
eMail Center.

Steps
1. Creating Email Accounts on the Email Server

2. Creating User Accounts

3. Defining Email Server Accounts

4. Creating an eMail Center Agent

5. Setting up Routing for Inbound Email.

6. Configuring eMail Center Properties

7. Configuring UWQ to Launch the Business Application

8. Creating Classifications and Themes

9. Creating Suggested Response Documents and Associated Queries

10. Using Email Processing Workflow

11. Administering Concurrent Manager

1.8.1 Creating Email Accounts on the Email Server
For detailed information about creating email accounts on the Email Server, refer to 
the Managing Directory Information chapter of the Oracle Email Server 
Administration documentation (Creating Email Server User Accounts section).

1.8.2 Creating User Accounts
Oracle eMail Center ships with four default responsibilities: eMail Center 
Administrator, eMail Center Operations Manager, eMail Center DBA, and eMail 
Center Client. The process of setting up Users with each of these Responsibilities 
consists of several steps.
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1. Creating an employee (forms app)

2. Creating an application user and assigning user responsibilities (forms app)

3. Setting JTF default profiles (forms app)

4. Setting UWQ Default Profiles (forms app)

5. Creating CRM resource (forms app)

t You cannot perform this step until the OES accounts are defined in eMail 
Center

1.8.2.1 Creating an Employee with HRMS
Use this procedure to create employees with the Oracle Human Resources 
Management System.

Prerequisites
To perform the following steps, you must have Oracle HRMS installed and 
configured. If you do not have Oracle Human Resources Management System 
installed, you will need to create the employee using the Oracle Resource Manager 
application.

Note: You should have system administrator level access to the 
forms based applications to perform these tasks.

Table 1–1 Steps Necessary to Create Specific User Accounts 

Step: 1 2 3 4 5

DBA X X

Admin X X X

Ops. Manager X X X X

Agent X X X X Xt

Note: You cannot create a CRM Resource for an agent at this time. 
You must first define the email server accounts as shown in the 
“Defining Email Server Accounts” topic.
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Steps
1. From the Forms application login screen, login using the default system 

administrator user name and password.

2. From the list of application responsibilities, select US HRMS Manager.

The Navigator-HRMS Manager screen appears, displaying a list of functions.

3. From the list of functions, double-click People.

4. Double-click Enter and Maintain.

The Find Person screen appears.

5. In the Find Person screen, click New.

The People form appears.

6. On the form, enter all information in required fields, for example:

■ Last - (name)

■ First - (name)

■ Title - (select from the drop-down list)

■ Type - (select from the drop-down field)

■ Employee Number

■ Birth Date

■ Social Security Number (for US version only)

7. Save the record to complete the process of creating an employee.

References
For more information and detailed steps on creating employees, refer to the Oracle 
HRMS/Payroll documentation.

1.8.2.2 Creating an Application User and Assigning Responsibilities
Use this procedure to create application users and assign responsibilities.

Note: If the employee already exists, you do not need to perform 
this step.
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Steps
1. Select File and switch responsibility to System Administrator.

2. In the Functions tab, navigate to Security > User > Define.

3. Enter the User Name and Password.

4. In the Person field, select the name of the person that you created in HRMS.

5. Select the appropriate eMail Center Responsibility or Responsibilities.

6. Click Save.

7. Repeat steps 1 through 6 for each user and each responsibility.

8. For an agent, in addition to assigning the eMail Center client Responsibility, 
you must assign a business application Responsibility, for example, Customer 
Care or TeleService.

1.8.2.3 Setting JTF Default Profiles
Use this procedure to set JTF default profiles.

Prerequisites 
You must know the responsibility ID for eMail Center Administrator, Operations 
Manager and Agent before setting the JTF profile. To find the responsibility ID, 
perform the following steps:

1. From the Navigator System Administrator screen, click Security, 
Responsibility, then Define.

2. Query the desired responsibility based on the table below:

Table 1–2 User Types and Responsibilities 

User Type Responsibility

Administrator eMail Center Administrator

Operations Manager eMail Center Operations Manager

DBA eMail Center DBA

Agent eMail Center Client (agent interface)

Note: Create a unique User Name for each employee.
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3. From the Help menu, click Diagnostics > Examine.

The Examine Field and Variable Values screen appears.

4. If the password prompt appears, enter the ORACLE password for the APPS 
account.

5. Click the drop-down list in Field.

The Choose a Field screen appears.

6. From the list in the Choose a Field screen, select the RESPONSIBILITY_ID.

7. Click OK.

The value of the RESPONSIBILITY_ID is displayed in the Value Field of the 
Examine Field and Variable Value screen.

8. Click OK.

Steps
1. From the Navigator System Administrator screen, click Profile, then System.

The Find System Profile Values screen appears.

2. Click the User check box and from the drop-down list in the User field, and 
select the user name.

3. In the Profile field, type JTF_PROFILE_DEFAULT% and click Find.

A list of system profile values appears.

4. In the User column, set the values for these profiles according to the following 
table.

Table 1–3 User Types and Responsibilities 

User Type Responsibility

Administrator eMail Center Administrator

Operations Manager eMail Center Operations Manager

Agent eMail Center Client (agent interface)
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5. From the File menu, click Save.

1.8.2.4 Setting UWQ Profiles
In setting up Universal Work Queue for email, there are several questions which 
determine the profile settings.

Site Level Versus User Level
If all of your agents will be doing email or all will be both email and telephony, then 
you can set those profile values in UWQ at the site level. If different agents will 
handle different media duties, then set the profile values at the user (agent) level for 
each individual user.

A setting at the user level will override a setting at the site level, so if the site is 
email only, you can set a particular agent to both email and telephony by setting the 
email and telephony profile values for that particular user. Most of the UWQ 
profiles have default values that can remain unchanged.

For details on each value, see the Universal Work Queue Implementation Guide.

Common Cases
To configure email on a working UWQ, change or verify the UWQ profile setting 
listed below that applies to your implementation.

1.8.2.4.1 Email Only  

Table 1–4 JTF Profile Values 

Profile Value Description

JTF_PROFILE_DEFAULT_
APPLICATION

680 eMail Center value for the 
application ID.

JTF_PROFILE_DEFAULT_
LANG

US This is the language code. (It is 
possible that you may not have this 
profile. If this is the case, your 
language setting is controlled by the 
ICX: Language profile).

JTF_PROFILE_DEFAULT_
NUM_ROLES

15

(recommended)

This determines the number of 
rows you can see on each page 
when in browse mode.

JTF_PROFILE_DEFAULT_
RESPONSIBILITY

This is the value responsibility ID 
you obtained in the prerequisite 
steps.
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IEU : Queue : Inbound Email : Yes

IEU : Queue : Inbound Telephony : No

IEU : Queue : Web Callback : No

1.8.2.4.2 Email and Inbound Telephony  

IEU : Queue : Inbound Email : Yes

IEU : Queue : Inbound Telephony : Yes

IEU : Queue : Web Callback : No

1.8.2.4.3 Email and Inbound Telephony and Web Callback  

IEU : Queue : Inbound Email : Yes

IEU : Queue : Inbound Telephony : Yes

IEU : Queue : Web Callback : Yes

Steps
1. To set the UWQ profiles at the Site level, check the Site box in the Display area.

2. To set the UWQ profiles at the User level, check the User box and select the 
appropriate user from the list of values.

3. Type IEU:% in the Profile field (this will search for the appropriate profiles).

4. Click Find.

A list of profiles appears.

5. In the list of profiles, find IEU: Queue: Inbound Email.

6. From the drop-down list in the Site / User field, select YES.

7. Save the record.

8. Repeat steps 5 through 7, selecting profiles for IEU: Queue: Inbound 
Telephony and IEU: Queue: Web Callback.

9. In the list of profiles, find IEU: Blending Style, and then select Not Blended 
from the drop-down list in the User / Site field.

10. Save the record to complete the process of setting up UWQ profiles.
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1.8.2.5 Setting CRM Resources
These steps should be performed to set CRM Resources for users with the 
Operations Manager responsibility.

Use this procedure to set the CRM resources.

Steps
1. From the Navigator System Administrator screen, click File, then Switch 

Responsibility.

2. Select the CRM Administrator responsibility.

A screen appears, displaying a list of functions.

3. From the list of functions, double-click the Resource Manager.

4. Double-click Maintain Resources.

5. Double-click Import Resources.

The Selection Criteria screen appears.

6. From the Resource Category field, select Employee.

7. From the Name field, select the new employee’s name.

8. Click Search.

The Search Results list appears, displaying a row of data with Category set to 
Employee and Name set to the new employee’s name.

9. Click Create Resource.

The Default Values screen appears.

10. Click OK.

The Selected Resource screen appears.

11. In the Selected Resources screen, click Save Resource.

12. Click Details.

The Resource screen appears.

13. In the Roles tab, select Marketing Encyclopedia from the drop-down list for 
Role Type and select MES Administrator from the drop-down list for Roles 
(this allows integration with the MES application).

14. Accept the default values on the remaining tabs.
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15. From the File menu, click Save to save the resource.

1.8.3 Defining Email Server Accounts
This topic group provides a high-level overview of the steps necessary to define 
Email Server accounts in the eMail Center System Administrator Interface, a 
worksheet for gathering all the necessary information, and detailed steps for 
performing each part of the defining Email Server accounts procedure.

1.8.3.1 High-Level Steps

Prerequisites
To perform the following steps, you must have an administrator level status.

Steps
1. Create a Server Group entry.

2. Define an eMC Server entry and assign the eMC Server entry to the previously 
created Server Group.

3. Define an Email Db entry and assign this Email Db entry to the previously 
created Server Group.

4. Define one database link and create two others. You will define the link from 
OES to the Apps instance created earlier, and you will create two links to your 
Email Db (your Oracle Email Server database). One link for user <oraoffice> 
and one for user <OO>. In a single instance scenario, the database link would 
be self-referencing.

5. Define two Email Server entries, one IMAP and one SMTP, and assign them to 
the previously created Server Group.

6. Create an account for every user.

1.8.3.2 Worksheets
Use the following worksheet to gather all the necessary information for completing 
the detailed tasks in the Defining Email accounts procedure.

Note: The eMail Center System Administrator Interface is an 
HTML based console and is separate from the Oracle Applications 
forms based Admin console.
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Create Server Group
Group Name: any unique name that you want to assign to a group.

Group Description: any free-form text that you want to use to describe the group.

Create EMC Server
EMC Server Name: any unique name that you want to assign to this server.

IP Address: the IP address of the machine on which the server is running.

DNS Name: the unique machine identifier on the network.

Group Server: the server group of which this server is a part, set in the previous 
step.

Create Email Database Server
Database Name: any unique name that you want to assign to the server.

Host Name: the domain name of the machine on which the server is running.

Port: the SQL *Net port of the database.

Protocol: the protocol for network communication, for example, TCP.

Database SID: standard system identifier for the database.

Server Name: the DNS entry of the machine on which the database is running. 

Database Description: any free-form text that you want to use to describe the 
database.

RT Availability: run time availability, the default is YES.

Group Server: the server group of which this server is a part, set in the previous 
step.

Create Database Link
Database Name: the name of the eMail DB.

Database Global Name: the GLOBAL_NAME of the Oracle Email Server database. 
Enter the GLOBAL_NAME parameter value of the eMail DB for the OO and 
ORAOFFICE database links (from the application database to the Oracle Email 
Server), or the name of the APPS database link (from Oracle Email Server to the 
application database).

User: the database user.
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Password: the password for the database user.

Create Email Server
Server Name: any free-form text that you want to use to describe the server.

DNS Name: the unique machine identifier on the network.

IP Address: the IP address of the machine on which the server is running.

Port: the port on which the IMAP server is running.

RT Availability: run time availability.

Group Server: the server group of which this server is a part, set in the previous 
step.

Server Type: the Email Server type. Select IMAP or SMTP.

Create Account
Name: any free-form text that you want to use to describe the account.

Email Account: the email account name.

Profile: any free-form text that you want to use to describe the account.

Email Server: the name of the eMail DB.

Interaction Center: the name of the interaction center server group.

1.8.3.3 Detailed Steps
Use the following procedures to define Email Server accounts.

Define Email Server Group
1. From the HTML login screen, type the eMail Center administrator user name 

and password.
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The eMail Center System Administrator Interface appears, displaying the 
Account, Server, and Queue tabs.

2. Click the Server tab and then the Group sub-tab.

The Server Groups screen appears.

3. From the Server Groups screen, click Create.

The Create Group screen appears.

4. Type a group name and a group description in the provided fields.

5. Click Create to save the record.

The server group is created and you return to the Server Groups screen.

Define EMC Server
1. From the Server tab, click the EMC sub-tab.

The EMC Servers screen appears.

2. From the EMC Servers screen, click Create.

The Create EMC Servers screen appears.

3. Type the EMC server name, DNS name, and IP address in the provided fields.

4. From the drop down list in the Group Server field, select the server group you 
previously created.

5. Click Create to save the record.

Note: The email server group is different from the interaction center 
server group. The Email Server Group contains only email specific 
servers, such as IMAP, SMTP, OES Database and Email Center 
(EMC) servers. The Interaction Center Server Group contains 
UWQ, OTM, ITS, Routing and generic interaction center servers, 
plus the Email Center Server (EMC). The only server in common 
between the different server groups is the EMC server, so you must 
set up that server twice.

Note: If you do not see your new server group displayed, use the 
Next and Last commands to locate it in the list.
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The EMC server is created and you return to the EMC Servers screen.

Define Email Database Server
1. From the Server tab, click the Email DB sub-tab.

The Database Servers screen appears.

2. From the Database Servers screen, click Create.

The Create Database screen appears.

3. Type the database name, host name, port, protocol, database SID, Service Name, 
database description, and RT availability in the provided fields.

4. From the drop down list in the Group Server field, select the server group you 
previously created.

5. Click Create to save the record.

The database server is created and you return to the Database Servers screen.

Create Database Link

Steps
1. From the Server tab, click the DB Link sub-tab.

The Database Links screen appears.

2. From the Database Links screen, click Create.

The Create Database Link screen appears.

Note: If you do not see your new EMC server displayed, use the 
Next and Last commands to locate it in the list.

Note: If you do not see your new database server displayed, use the 
Next and Last commands to locate it in the list.

Note: You will need to perform these steps three times: first, for the 
<oraoffice> user, next for the <OO> user, and then to define the link 
from OES to Apps that you created earlier.
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3. From the drop-down list in the Database Name field, select the database name.

4. Type the Database Global Name, User and Password in the provided fields.

5. Click Create to create the record.

The database link is created and you return to the Database Links screen.

Define Email Server

1. From the Server tab, click the Email sub-tab.

The E-mail Servers screen appears.

2. From the E-mail Servers screen, click Create.

The Create E-mail Server screen appears.

3. Type the server name, DNS name, IP address, port, and RT availability in the 
provided fields.

4. From the drop down list in the Group Server field, select the server group you 
previously created.

5. From the drop-down list in the Server Type field, select the email server type.

6. Click Create to create the record.

The email server is created and you return to the E-mail Servers screen.

Queues
The Queue tab displays information about eMail Center queues. Queues are 
enabled by default. Clicking Refresh updates the status of the queues.

Note: These steps apply to the OES processes, not to the EMC 
Server. You need to perform these steps twice: once to define the 
IMAP server and again to define the SMTP server. IMAP is the 
protocol for the Agent UI to talk to the server, and SMTP is the 
protocol for communications across the internet.

Note: If you do not see your new email server name displayed, use 
the Next and Last commands to locate it in the list.
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Create Account
Follow the steps below to create accounts, for example, Classification, Support.

1. Click the Account tab.

The Accounts screen appears, displaying information in table form for all 
current accounts.

2. Click Create.

The Accounts screen appears.

3. Type the account information in the Name, Email Account, Domain, Profile, 
Email Server, and Interaction Center fields.

4. Click Create to create the record.

You are returned to the accounts screen and your new account is displayed in 
the table.

5. Repeat steps 2 through 4 for each account.

For each email account defined in the eMail Center Admin console, the following 
folders are automatically created:

Resolved - The “Resolved” folder stores all incoming messages for that particular 
account, once the agent responds to it. For example, when an agent clicks on the 
“Send” button from either the “Respond” or “Forward” screen, the original 
incoming message is moved from the agent’s folder to the “Resolved” folder for 
that particular account.

Sent - A copy of each email response generated by an agent is stored in the “Sent” 
folder for that particular account. When an agent clicks on the “Send” button from 
either the “Respond” or “Forward” screen, a copy of the outgoing email message is 
made and stored in the “Sent” folder for that particular account.

Deleted - The “Deleted” folder stores all incoming messages that were deleted. 
When an agent clicks on the “Delete” button from the “Preview” screen, the original 

Note: You must create at least one Email Account (for example, 
Support, Sales, and so on) to associate with your agents.   Each 
agent must be associated with an account. You also must create an 
account called ‘classification’, if you wish to set up themes and 
classifications in the system.
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incoming message is moved from the agent’s folder to the “Deleted” folder for that 
particular account.

Retry - The “Retry” folder stores all messages that fail with API errors while they 
are being processed. There is a concurrent manager request ’Process Retry Folder’ 
that can be scheduled to reprocess these messages.

Admin - The “Admin” folder stores all messages that fail while reprocessing from 
the Retry folder. An administrator manually monitors this folder.

Using the above default folders, eMail Center provides the mechanism to store all 
incoming emails and a copy of all outgoing emails.

1.8.4 Creating an eMail Center Agent

1.8.4.1 Setting CRM Resources
When logged in to Forms, perform these steps to set CRM Resources for each eMC 
Agent user.

Use this procedure to set the CRM resources.

Steps
1. From the Navigator System Administrator screen, click File, then Switch 

Responsibility.

2. Select the CRM Administrator responsibility.

A screen appears, displaying a list of functions.

3. From the list of functions, double-click Resource Manager.

4. Double-click Maintain Resources.

5. Double-click Import Resources.

The Selection Criterion screen appears.

6. From the Resource Category field, select Employee.

7. In the Name field, select the name of the new employee that you created 
previously in the HRMS or Resources.

8. Click Search.

The Search Results list appears, displaying a row of data with Category set to 
Employee and Name set to the new employee’s name.
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9. Within the Search Results list, click the Select box for the appropriate employee.

10. Click Create Resource.

The Default Values screen appears.

11. Click OK.

The Selected Resources screen appears.

12. From the Selected Resources screen, click Save Resource.

13. Click Details.

The Resource screen appears.

14. In the Interaction Center tab, from the drop-down list in the Interaction Center 
field, select the interaction center that you defined previously.

15. Continuing in the Interaction Center tab, Email Parameters area, from the 
drop-down list in the Email Account field, select the desired Email Account. 
Select Default from the drop-down list for the Parameter field and click the 
Value field to select the default value (IEM_DEFAULT_VALUE).

16. In the Roles tab, select Call Center from the drop-down list for Role Type and 
select Call Center Agent or Call Center Supervisor or Call Center Manager 
from the drop-down list for Roles. This is required for integration with the 
Routing Server. 

17. From the File menu, click Save to save the resource.

Default folders created for every agent
For every eMail Center user to whom eMC Agent responsibilities are assigned, the 
following folders are created automatically in the Oracle eMail Server:

Agent’s User Name - For every account that an agent is assigned to, a folder 
bearing the agent’s user name will be created.

Draft - For every account that an agent is assigned to, a “Draft” folder will be 
automatically created under the folder bearing the agent’s user name.

Note: Use the default values for all tabs except the Interaction 
Center tab and the Roles tab. Do not perform any changes to the 
other tabs unless explicitly directed to do so.
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1.8.5 Setting up Routing for Inbound Email
Use the steps in the following chart to set up rules-based routing. The Window 
Name(s) column shows you in which window(s) you perform a step, and for which 
responsibility the window is available. The Required column shows you if the step 
is required, optional, required with defaults, or conditionally required.

1.8.5.1 Defining Groups
There are two types of groups for rules-based routing: static and dynamic. A static 
group requires that you manually edit information about individual group 
members. In a dynamic group, information about group members is updated 
automatically as the result of a SQL query.

For procedures, see:

■ Defining a Static Group

■ Defining a Dynamic Group

1.8.5.1.1 Defining a Static Group  

Use this procedure to configure a static group for routing.

Step 
Number Required? Oracle Sales Setup Step Description Window Name(s) Responsibility

❏ Step 1 Required 
for 
rules-based 
routing

Define a group.

See: “Defining Groups” in this document

Define Groups 
window; Dynamic 
Groups window

CRM Resource 
Manager

❏ Step 2 Required 
for 
rules-based 
routing

Define a route.

See: “Defining Routes” in this document

Routing 
Administration 
window

Oracle Call 
Centers

❏ Step 3 Required 
for 
rules-based 
routing

Define the route priorities.

See: “Defining Route Priorities” in this 
document

Routing Priority 
window

Oracle Call 
Centers

❏ Step 4 Required 
for 
rules-based 
routing

Define the classifications.

See: “Defining Routing Classifications” in 
this document

Classification 
Administration 
window

Oracle Call 
Centers
Implementing Oracle eMail Center 1-47



Implementation
Prerequisites
None

Steps
1. Navigate to the Define Groups window.

■ In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Server Administration.

The Routing Administration window appears.

a. Click Static Groups.

The Define Groups window appears.

2. In the Name field, enter a unique descriptive name of the group.

3. In the Active Dates area, select or enter the Start Date.

4. To assign agents exclusively to this group, check the Exclusive Flag box. This 
means the agent may not be a member of any other group.

5. Click the Members tab.

6. In the Category field, select Employee from the list of values.

7. In the Number field, select the resource number of the appropriate agent. You 
can assign as many group members as you want.

The Name and Operating Unit fields are populated automatically.

8. Click the Usages tab.

9. In the Usage field, select Call Center from the list of values.

Note: The Accounting Code and Email Address fields are not 
required in email routing.

Caution: Enter an End Date only if you want to terminate the 
group. If you do not have an active group, the routing will fail and 
eMail Center will not be functional. 

Use extreme caution when using this feature!
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10. Optionally, if you want to define this group as a sub-group of another static 
group, click the Relations tab.   

1. Select the Group Number from the list of values in the Group Number 
field.

2. In the Relation Type field, select the default value Parent Group.

3. In the Active Dates area, select or enter the Start Date.

11. Select File > Save.

1.8.5.1.2 Defining a Dynamic Group  

Use this procedure to configure a dynamic group for routing.

Prerequisites
None

Steps
1. Navigate to the Dynamic Groups window.

■ In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Server Administration.

The Routing Administration window appears.

b. Click Dynamic Groups.

The Dynamic Groups window appears.

2. If necessary, choose File > New.

Note: When defining a static/dynamic group for Routing, the 
usage of the group should be set to “Call Center” so that the group 
will be available in the Routing Admin LOV for static/dynamic 
groups.

Caution: Enter an End Date only if you want to terminate the 
relation between the parent group and the sub-group. 

Use extreme caution when using this feature!
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3. Enter a unique name for the group.
4. In the Usage field, select Call Center from the list of values.

5. Optionally, enter a free text description of the group.

6. In the Active Dates area, select or enter the Start Date. 

7. Enter the SQL statement that selects the members of the group. The SQL 
statement must return only a list of resource IDs.

8. Click Check Syntax.

If the SQL statement is invalid, then an error message appears. If the SQL 
statement is valid, then no message appears. This does not check that the return 
values are valid, only that the SQL is well formed.

9. From the File menu, choose Save.

1.8.5.2 Defining Routes
A route definition identifies the potential groups or members to which an email 
may be routed and the email parameters (such as Email User Name) to be used in 
determining the destination of an email.

There are two types of rules-based routing, static and dynamic. 

Static routing consists of rules defined in the routing administration form, which 
then direct the email to either a static or dynamic group. An example of a static 
route would be “if the email user name = support then route to Group A”. Group A 
could be either a static group or a dynamic group. As defined in the previous 

Note: When defining a static/dynamic group for Routing, the 
usage of the group should be set to “Call Center” so that the group 
will be available in the Routing Admin LOV for static/dynamic 
groups.

Caution: Enter an End Date only if you want to terminate the 
group. If you do not have an active group, the routing will fail and 
eMail Center will not be functional. 

Use extreme caution when using this feature!
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section, a static group is cached by the routing server and a dynamic group is 
evaluated by a SQL query. 

Dynamic routing consists of rules defined in the routing administration form, which 
then direct the email to either a PL/SQL procedure or the routing workflow.   The 
rule itself is similar to static routing, but the destination of the rule is different. An 
example of the first type would be “if the email user name = support then route to 
the agents returned by the PL/SQL procedure ‘CUST_GET_AGENTS’”.   An 
example of using the routing workflow would be “if the email user name = support 
then route to the agents returned by the routing workflow ‘CCT_
ROUTINGWORKFLOW_PUB.LAUNCH_WORKFLOW_VERSION5’ “. 

For procedures, see:

■ Defining a Static Route

■ Defining a Dynamic Route

1.8.5.2.1 Defining a Static Route  

Use this procedure to define a static route.

Prerequisites
Define a static group or a dynamic group. For more information, see Defining 
Groups.

Steps
1. Navigate to the Routing Administration window.

■ In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Server Administration.

The Routing Administration window appears.

2. If necessary, choose File > New.

3. In the Route Definition area:

a. Enter a unique name to describe the route.

b. From the Route Type list, select Static.

c. In the Default Destination field, select a group (static or dynamic) from the 
list of values.
Implementing Oracle eMail Center 1-51



Implementation
d. Optionally, enter the free text Description of the static route.

e. For static routes, select the default Application Database.

4. On the Route Rules tab, define the rules for the route.

a. From the Key list, select a key (for example, Email User Name).

b. Enter the value for the selected key (for example, Support).

5. On the Route Destinations tab, select the static groups or dynamic groups to 
which email may be routed.

6. From the File menu, choose Save.

1.8.5.2.2 Defining a Dynamic Route  

Use this procedure to define a dynamic route.

Prerequisites
None

Steps
1. Navigate to the Routing Administration window.

■ In the Navigator window, on the Functions tab, choose Call Center Admin 
> Routing Administration.

The Routing Administration window appears.

2. If necessary, choose File > New.

3. In the Route Definition area, identify the route.

a. Enter a unique name to describe the route.

b. From the Route Type list, select Dynamic.

Note: If the routing server cannot determine agents from the 
defined destinations, then the server routes the email to the agents 
defined in the Default Destination.

Note: ✣ haining rules is only available for ‘and’ relations. For 
example, a rule can be “if X=Y and A=B” but not “if X=Y or A=B”.
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c. In the Default Destination field, select a group (static or dynamic) from the 
list of values.

d. Optionally, enter the free text description of the dynamic route.

e. If either of the following conditions is true, select Application Database:

The PL/SQL procedure that is the route destination is stored in the Oracle 
Applications database.

OR

The routing workflow is the route destination.

f. If the following condition is true, select Non Application Database: The 
PL/SQL procedure that is the route destination is stored in the Non 
Applications database. Also, enter a Database Driver and Database URL 
for the Non Application database.

4. On the Route Rules tab, define the rules for the route.

a. From the Key list, select a key (for example, Email User Name).

b. Enter the value for the selected key (for example, Support).

5. On the Route Destinations tab:

a. In the Dynamic Destination area, enter the name of the custom procedure 

(Package.Procedure) that will be used to derive the list of agents for this 
email.   The custom procedure must return nothing but a semi-colon 
delimited list of agents. 

OR

Select the routing workflow from LOV.

b. If you are using a custom procedure, in the Procedure Parameters area, 
enter the procedure parameters. This allows the system to know about each 
input and output parameter for your custom procedure:

Parameter: The name of the parameter for the procedure (either input 
and/or output).

Note: If the routing server cannot determine agents from the 
defined destinations, then the server routes the email to the agents 
defined in the Default Destination.
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Value: Choose the Value from the list of values, or enter a custom value for 
this parameter.

Data Type: Choose the Data Type of the parameter from the list of values.

Direction: Choose the direction of the parameter from the list of values to 
determine if it is an input and/or output parameter. 

Sequence: A generated number that indicates the position of the parameter 
in the PL/SQL procedure. Verify that the accuracy of the parameter 
Sequence.

Define all parameters for the procedure.

6. From the File menu, choose Save.

1.8.5.3 Defining Route Priorities
You can define and change the priority of route definitions. Logically, the route 
rules will be evaluated in order or priority, starting with 1. The first route rule 
which evaluates as true will determine the routing destination.

Changing the value of a route priority affects the values of other route priorities. If 
you increase the value of a priority, then the priorities of all the routes with a value 
equal to or greater than the original value decrease by one. If you decrease the value 
of a priority, then the value of all the routes with a value equal to or less than the 
original value increase by one. For example, if you decrease 6 to 3, then 3 increases 
to 4, 4 increases to 5, and so on. If you increase 3 to 6, then 4 decreases to 3, 3 
decreases to 2, and so on.

Use the following procedure to set the priority for a route.

Prerequisites
None

Steps
1. Navigate to the Routing Priority window.

a. In the Navigator window, on the Functions tab, choose Call Center Admin > 
Routing Priority Administration.

Note: By default, newly defined routes have the lowest priority 
among the existing routes.
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The Routing Priority window appears.

2. From the Priority list of values, select a priority.

3. Click Change Priority.

4. From the File menu, choose Save.

1.8.5.4 Defining Routing Classifications
Classifications specify which business application is launched on the agent desktop 
and how an interaction is listed in the UWQ screen. Classifications are of two types: 
literal and database procedure. A literal classification assigns the string specified to 
be the classification of an interaction.    A database procedure classification derives 
the classification value from a stored procedure and then assigns it to an interaction. 

Every classification must have rules that define the conditions under which the 
classification occurs. For example, if Customer Name=Oracle Corporation then the 
classification=Gold Support.

A classification can have multiple rules associated with it. Every classification rule 
has a Key and a Value whose relationship is defined by one of the available 
Operations (=, !=, >, >=, <, <=).

For procedures, see:

■ Defining a Literal Classification

■ Defining a Database Procedure Classification

1.8.5.4.1 Defining a Literal Classification  

Use this procedure to define a literal classification.

Prerequisites
None

Note: Routing Classification is different from Email Classification. 
Email classification is the intent of the email. Routing Classification 
determines how an interaction is tracked in UWQ and Business 
Intelligence, and which business application is popped when the 
media arrives on the desktop.
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Steps
1. Navigate to the Classification Administration window.

■ In the Navigator window, on the Functions tab, choose Call Center Admin 
> Classification Administration.

The Classification Administration window appears.

2. If necessary, choose File > New.

3. In the Classification Definition area, define the classification.

a. Enter a unique name to describe the classification.

b. From the Type list, select Literal.

c. In the Time Out field, enter the number of minutes you want to use as your 
time out period.

After a email is routed, it waits in the OTM queues for one of the agents in 
the group to become available. The Time Out field sets the maximum length 
of time that the email waits in the OTM queues. By the end of that period, if 
an agent does not become available, the email is sent back to the Routing 
server to be re-routed to another group of agents. The Time Out field is set 
in minutes.

For email, if you do not want the email to be rerouted for a long period, 
Oracle recommends that you enter the number 100000 in this field.

d. Choose the default Application Database.

4. On the Classification Rules tab, define the rules for routing based on the keys 
identified in the route definition.

a. From the Key list, select a key.

b. From the Operation list, select an operator.

c. Enter the value for the selected key.

5. From the File menu, choose Save.

1.8.5.4.2 Defining a Database Procedure Classification  

Use this procedure to define a database procedure classification.

Prerequisites
None
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Steps
1. Navigate to the Classification Administration window.

■ In the Navigator window, on the Functions tab, choose Call Center Admin 
> Classification Administration.

The Classification Administration window appears.

2. In the Classification Definition area, define the classification.

a. Enter the name of the database procedure that will determine the 
classification of the email, for example, GET_CLASSIFICATION_FROM_
SUBJECT.

b. From the Type list, select Database Procedure.

c. In the Time Out field, enter the number of minutes you want to use as your 
time out period.

After a email is routed, it waits in the OTM queues for one of the agents in 
the group to become available. The Time Out field sets the maximum length 
of time that the email waits in the OTM queues. By the end of that period, if 
an agent does not become available, the email is sent back to the Routing 
server to be re-routed to another group of agents. The Time Out field is set 
in minutes.

For email, if you do not want the email to be rerouted for a long period, 
Oracle recommends that you enter the number 100000 in this field.

d. Choose the default Application Database.

e. If the following condition is true, select Non Application Database:

The PL/SQL procedure that determines the classification is stored in the 
Non Applications database. Also, enter a Database Driver and Database 
URL for the Non Application database.

3. On the Classification Rules tab, define the rules for classification.

a. From the Key list, select a key.

b. From the Operation list, select an operator.

Note: The value entered in the Classification field is not verified 
against the stored procedures. Be sure to enter the correct 
procedure name.
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c. Enter the Value for the selected key.

4. In the Classification Parameters tab, enter the following parameters:

Parameter: The name of the parameter for the procedure.

Value: Choose the Value from the list of values, or enter a custom value for 
this parameter.

Data Type: Choose the Data Type of the parameter from the list of values.

Direction: Choose the direction of the parameter from the list of values.

Sequence: A generated number that indicates the position of the parameter 
in the PL/SQL procedure. Verify that the accuracy of the parameter 
Sequence.

Define all parameters for the procedure.

5. From the File menu, choose Save.

1.8.6 Configuring eMail Center Properties
Use this procedure to configure the properties for eMail Center. This procedure 
provides the UWQ Server with the URL to launch the eMail Center UI. This step is 
only required when setting up the system for first time use, or after changing the 
Apache server root.

Steps
1. From the HTML login screen, type the default system administrator user name 

and password.

The CRM default screen appears.

2. From the default screen, click the Advanced tab.

The Advanced screen appears.

3. From the Advanced screen, click the Properties sub-tab.

4. From the View drop-down list on the Properties sub-tab, select IEM.

A list of Key Details appears.

5. From the list, click the link iem.base.url.
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6. Type the Apache server system root URL in the Value field (for example, 
http://www.visioncorp.com:8000/)

7. Click Update.

You return to the previous screen.

References
For more information, refer to the “Administering Oracle eMail Center” section of 
the Oracle eMail Center Concepts and Procedures documentation.

1.8.7 Configuring UWQ to Launch the Business Application
Follow the steps below to define the business application which UWQ will launch 
when emails are delivered to users.

Prerequisites
Any application that needs to be launched on the agent desktop must be 
successfully installed, configured, and made available to UWQ.

Steps
1. From the Forms application, log in using an account that has access to the 

Universal Work Queue Administration responsibility. 

2. Double click the UWQ Administration menu.

The Media-Action-Classification-Association form appears.

3. Select Inbound Email from list of values in the Media Type field.

Note: If the list of links does not appear after step 4, click Create 
and the Create Key screen appears. Type iem.base.url in the Key 
field and move on to step 6.

Notes:

■ The last slash (/) in the URL is required.

■ You need only one Key Detail for iem.base.url.
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4. In the Classification field, enter the Routing Classification that you want to 
associate with the screen pop or Media Action. 

5. From the list of values in the Media Action field, select Customer Care Media 
function.

6. From the File menu, choose Save.

1.8.8 Creating Classifications and Themes
Resolving interactions involves two major challenges:

■ Understanding the intent of the communication. What is being requested or 
communicated?

■ Determining the appropriate responses or actions necessary to resolve the 
interaction

These challenges can be answered by human intervention (an agent reads and 
responds), a semi-automated process that requires human assistance, or a fully 
automated analysis and response.

A fully automated process requires three processes:

■ Beginning: Analyze the intent of the unstructured email message

■ Middle: Classify the intent

■ End: Suggest one or more responses to the message, based on the classification

Oracle eMail Center uses the iMT (interMedia Text) feature of the Oracle 8i database 
to analyze incoming email messages based on the linguistic properties of the 
various parts of the email, such as header, subject, body and attachments. The term 
“classification” refers to the category under which the email should be classified. A 

Notes:

■ If you do not enter a value for Classification, the default 
application for the selected Media Type will be the application 
that you select in the Media Action field. 

■ The Classification field is case sensitive. The value that you 
enter here must exactly match the Classification that you 
entered in the Classification field in the Classification 
Administration form. 
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good example of classifications for a hardware company would be Accessories, 
Service, Product Information, Installation, etc.

Each classification has a set of underlying theme signatures that are used by iMT to 
classify the email. A theme signature is a combination of the themes and their 
respective scores for each classification.

All incoming unstructured emails are processed by iMT to generate a theme 
signature that is similar to the classification theme signatures. Emails are classified 
by comparing the incoming message theme signatures with classification theme 
signatures. The four best matches are selected. 

After a message is classified, eMail Center creates a search string based on the 
combination of the incoming message theme signature and the response theme 
signature. This search string is then used to query the MES database to retrieve the 
suggested response documents.

Classifications and themes can be created in two ways:

■ By sending email to the “classification” email account

■ From the eMail Center Operations Manager Console

1.8.8.1 Creating Classifications and Themes by Sending Email
Use this procedure to create classifications by sending email to the “classification” 
email account.

Prerequisites
A “classification” email account should be created on the Email Server and should 
also be defined in the eMail Center.

Note: Please note the distinction between eMC classifications and 
the classifications derived by the routing server.

■ eMC classifications indicate the intent of a message.

■ Routing classifications are used in the UWQ UI to display 
media items and may or may not relate to the intent of a 
message.

■ Routing classifications can be the account name into which the 
email arrived.
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Steps
1. Send an email to the “classification” account you created with the subject line 

reading:

<Classification Name><accountname@domainname><Q> 

OR

<Classification Name><accountname@domainname><R>

The letters ‘Q’ and ‘R’ above indicate whether the classification and corresponding 
theme signatures generated are for the incoming message (Q) or the outgoing 
response (R).

For example, if you created an email account called “support” for handling all 
support related issues and if you want to create a classification called “hardware” to 
categorize all hardware support issues, the email would have the following the 
subject line.

<hardware><accountname@domainname><Q> 

OR 

<hardware><accountname@domainname><R>

Based on whether you append the letter Q or the letter R to the subject line, the iMT 
will treat the email body as a sample inbound message or a sample response and 
generate themes with associated weights for the same.

References
For detailed information on creating email accounts on the Email Server, refer to the 
Managing Directory Information chapter of the Oracle Email Server Administration 
documentation (Creating Email Server User Accounts section).

For detailed information on defining Email Server Accounts in the eMail Center, 
refer to the Defining Email Server Accounts section of the Oracle Email Server 
Administration documentation.

Note: If the classification name specified in the subject line 
already exists, then the theme’s signatures (and their weights) will 
be updated for the existing classification based on the content of the 
email.
1-62 Oracle eMail Center Implementation Guide



Implementation
1.8.8.2 Creating Classifications from the Operations Manager Console
Use this procedure to create classifications from the eMail Center Operations 
Manager Console.

Prerequisites
You need to have an email account set up before you can create a classification.

Steps
1. Log in to the Admin Console as Operations Manager. 

The Classification screen appears.

2. From the Classifications screen, click Create.

The Create Classification screen appears.

3. In the Classification Name field, type the classification name.

4. From the drop down list in the Email Account field, select the email account.

5. Click Create.

The classification is created and you return to the Classifications screen.

1.8.8.3 Creating Themes from the Operations Manager Console
Use this procedure to create themes from the eMail Center Operations Manager 
Console.

Prerequisites
The eMail Center classification for which you are creating a theme must already be 
created.

Steps
1. Log in to the Admin Console as Operations Manager. 

The Classification screen appears.

2. From the Classifications screen, click the Themes sub-tab.

A drop down list appears, displaying all of the existing classifications.

3. From the drop down list, select the classification for which you wish to create 
themes.

4. Click Create.
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The Create Themes screen appears, displaying the selected classification name.

5. In the provided fields, type the name and score for the theme you are creating.

6. From the drop-down list in the Type field, select the type of theme.

7. Click Create.

The new theme is created for the selected classification and you return to the 
Classifications screen.

1.8.9 Creating Suggested Response Documents and Associated Queries
Suggested response documents are standard responses that are used by eMail 
Center agents when responding to an email enquiry. 

A suggested response document can be a Netscape Composer or an HTML 
document that may or may not have merge fields. A merge field is a place holder, 
for a variable which gets automatically filled when a query associated with 
document is fired. The associated query is executed when a response document is 
selected. The merge fields need to be enclosed within special tags, “«”, which can be 
entered by holding down the “Alt” key and typing “0171” on the numeric keypad 
(with the Num Lock Turned off), and “»”, which can be entered by holding down 
the “Alt” key and typing “0187” on the numeric keypad (with the Num Lock 
Turned off). Example:

Dear «CP_FIRST_NAME» «CP_LAST_NAME»,

Thank you for your interest in «PRODUCT_NAME». This product will be 
released on «RELEASE_DATE».

1.8.9.1 Create an Associated Query
Use this procedure to create a query in Fulfillment before associating it with a 
master document.

Prerequisites
None

Important: Merge Fields are case sensitive and should be referred 
to exactly the same as they were obtained from the query.
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Steps
1. From the HTML Login screen, login as the Fulfillment administrator.

2. Click the Query tab.

3. Click Create.

4. In the “Create Query” screen, type in data for the following fields.

■ Query Name - this name should be unique.

■ Query Description - a brief description of the query.

■ Query String - this is the SQL statement for the query. The number of fields 
in the “Select” clause should equal the number of merge fields in the master 
document. Do NOT end the query with a “;” or “/”, the standard SQL 
syntax to execute the query.

5. Click Create.

1.8.9.2 Associate the Suggested Response Document and the Query
To associate the suggested response document and the query to expand the merge 
fields in the document, you need the Document ID and the Query ID (which you 
should have obtained by performing the procedure in the preceding Note).

To obtain the document ID, run the following SELECT statement in SQL*Plus:

SELECT ITEM_ID
FROM JTF_AMV_ITEMS_TL
WHERE ITEM_NAME = ’DOCUMENT_TITLE’;

(Where DOCUMENT_TITLE is the title of the suggested response document you 
uploaded in MES).

To associate the suggested response document with the query, run the following 
INSERT statement in SQL*Plus:

INSERT INTO JTF_FM_QUERY_MES
VALUES (DOCUMENT_ID, QUERY_ID, SYSDATE, USER_ID, SYSDATE, USER_ID, NULL, 

Note: After creating the query, click on the query name displayed 
in the table under the Query tab. Make a note of the Query 
Identifier for the query that you just created. You will need this 
Identifier (ID) to associate the query with the suggested response 
document.
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NULL, NULL);

Where DOCUMENT_ID is the document ID of the suggested response document 
obtained by running the SELECT statement above.

QUERY_ID is the ID of the uploaded query (noted when the query was uploaded)

SYSDATE is a system variable provided by SQL*Plus that always has the value of 
the current system date. 

USER_ID is the user ID for the account you used to log in, e.g. 11001

NULL values are inserted in the final three columns since they are not related to our 
product

1.8.9.3 Uploading Suggested Response Documents and Message Format 
Templates
Oracle eMail Center (eMC) uses the Marketing Encyclopedia System (MES) as its 
document repository. This topic group describes the process of uploading response 
documents into the response document repository (also referred to as KB or the 
knowledge base). MES stores documents under different categories. 

eMail Center requires a category called “Email Center” to store suggested response 
documents. These documents are standard email responses that an agent may 
respond to an enquiry. Currently, eMail Center searches all available categories for 
suggested response documents.

eMail Center requires a category called “EMC Templates” to store the message 
format templates. These templates are style sheets used when composing an email 
in the eMail Center Agent UI. Currently, eMail Center ONLY searches the “EMC 
Templates” category for message format templates.
 

High-level steps
1. Create the category in MES (only performed once).

2. Define a hierarchy among categories (only performed once).

Important: To be created, eMail Center requires a minimum of 
two categories:

■ Email Center

■ EMC Templates
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3. Upload the documents into MES.

4. Verify the document was uploaded.

References
For more information on MES categories, refer to the Oracle Marketing Online and 
Oracle Marketing Encyclopedia System documentation.

1.8.9.4 Creating a Category in MES
Use this procedure to create a category in MES for the response templates.

Prerequisites
You must have a valid administrator login account.

Steps
1. Login to Oracle Marketing Online application (which owns the MES repository) 

as an administrator.

2. From the default screen in Marketing Online, click the MES tab.

3. From the MES tab, click the Administration sub-tab.

4. From the MES Administration sub-tab, click Category Manager.

The Category Manager screen appears.

5. In the provided fields, enter the category Name and a Description. 

6. Click Update.

Oracle Marketing Online creates the new category.

7. To create additional categories, repeat steps 5 and 6.

Important: To be created, eMail Center requires a minimum of 
two categories:

■ Email Center

■ EMC Templates
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1.8.9.5 Defining a Hierarchy Among Categories
Use this procedure to define a hierarchy among categories by creating 
sub-categories.

Prerequisites
Before you can define a hierarchy among categories, you must first create the 
categories as shown in the “Creating a Category in MES” topic.

Steps
1. Login to Oracle Marketing Online application (which owns the MES repository) 

as an administrator.

2. From the default screen in Marketing Online, click the MES tab.

3. From the MES tab, click the Administration sub-tab.

4. From the MES Administration sub-tab, click Hierarchy Manager.

The Hierarchy Manager screen appears, displaying a list of child and parent 
categories.

5. From the drop-down list in the Parent Name (left) column, select the 
corresponding parent category.

6. Click Update.

Oracle Marketing Online links the child category to the selected parent 
category.

7. If you created additional categories, create the appropriate hierarchies using 
steps 5 and 6.

1.8.9.6 Uploading Documents Into MES
Use this procedure to upload suggested response documents and message format 
templates into MES.

Important:

■ For the category Email Center, leave the parent name as 
“-None-”.

■ For the category EMC Templates, select the parent name “Email 
Center” from the list of values.
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Prerequisites
Before you upload response documents into MES, you must first create a category.

Steps
1. Login to Oracle Marketing Online application (which owns the MES repository) 

as an administrator.

2. From the default screen in Marketing Online, click the MES tab.

3. From the MES tab, click the Publish sub-tab.

4. From the drop-down list in the Item Type field, select the item type File.

5. In the provided fields, enter a Title, Author Name, and Description.

6. From the drop-down list in the Content Type field, select the content type 
Master Document.

7. Leave the Content Creation Date and Effective Start Date fields blank.

8. Select the Permanent radio button.

9. From the Category field, click Find.

The Find screen appears, displaying a list of the categories.

10. From the list, select the corresponding category. 

■ If the document that you are publishing is a message format template, 
expand the category tree for the category Email Center and select the 
category “EMC Templates.” 

■ You can expand the category tree by clicking the (+). Once the parent 
category expands, click the desired child category name to select it.

11. Click Upload File.

12. Click Browse to browse through the file system.

13. From the file system, select the document or template that you want to upload.

14. Click Open.

Caution: If you enter a value for a specific time period, the 
document will not be available after the time period has expired.
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The entire path for the selected document or template is now displayed under 
File Name.

15. Click Attach File.

The file uploads. Once the file has fully uploaded, the File Name is no longer 
displayed.

16. When the file or files have uploaded and the File Name disappears, click 
Finished.

The file name should display under Files.

17. Click Publish.

A success message appears on the top of the screen in red letters.

1.8.9.7 Verifying the Document Uploaded Successfully
Use this procedure to verify the document successfully uploaded into MES.

Prerequisites
Before you verify the success of your upload, you must first complete all the steps 
in the “Uploading Suggested Response Documents and Message Format Templates” topic.

Steps
1. Login to Oracle Marketing Online application (which owns the MES repository) 

as an administrator.

2. From the default screen in Marketing Online, click the MES tab.

3. From the MES tab, click the Categories sub-tab.

Important: Do not click any other button until the file has fully 
uploaded, or the upload process will fail. Also, if the response 
document contains one or more inline images, repeat steps 11 
through 15 for every image file (.gif or .jpeg) that needs to be 
included in the document or template.

Note: To publish another document you must start by clicking the 
Publish sub-tab again. Do not try to use (recycle) data entered for a 
previous file. 
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4. Click the category name under which you uploaded your response documents.

The name of the file and its description should appear. If not, go back and 
repeat the steps listed in the “Uploading Suggested Response Documents and 
Message Format Templates” topic.

1.8.10 Using Email Processing Workflow
Email Processing Workflow can be used out of the box without any configuration or 
customizing. The backbone of email processing is created by using Oracle 
Workflow, which is a part of Oracle Applications 11i. The name of the workflow for 
unstructured eMail Processing is “Mail Preprocessing.” 

This topic group provides an overview of unstructured workflow, a high-level view 
of the steps involved in configuring operations for workflow, and detailed 
instructions for performing each of the configuration steps.

Defining Workflows
To build or modify workflows, you use the Oracle Workflow Builder application. 
Oracle Workflow Builder lets you create, view, or modify a business process with 
simple drag and drop operations. Using the Workflow Builder, you can create and 
modify all workflow objects, including activities, item types, and messages.

Email Processing Workflow

Terms to Know
Activity - A unit of work performed during a business process.
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Node - An instance of an activity in a process diagram as shown in the Process 
window.

Process - A set of activities that need to be performed to accomplish a business goal.

Workflow - A workflow is a processing path, consisting of a series of process nodes 
linked together to form paths that support a particular business rule or set of 
business rules.

1.8.10.1 Unstructured Email Processing Workflow
The “Mail Preprocessing” workflow contains some mandatory nodes, which must 
be present to get messages processed and passed to the eMail Center server. The 
following table describes the nodes for mandatory workflow.

The Mail Preprocessing workflow also contains a node that is not mandatory, but is 
essential to enhance the functionality. The following table describes the nodes for 
non-mandatory workflow.

Table 1–5 Mandatory Workflow Nodes 

Node Name Function

Check Authorization Checks whether the message coming for the user has a valid 
email account. If not, it discards the message.

Check User Group Routes the message depending on the account for which it was 
sent. For example, if the message was sent to the “Support 
“account, then it branches to the path for Support. If there is no 
path for the “Support” account, it branches to the default path.

Classification Theme 
Repository

This node processes emails that are sent to the “Classification” 
account. Processes the classification and theme. Stores the 
query and response themes for each account.

Message Header 
Processing

Extracts the standard email message headers, for example, 
subject, date, from, to, and so on.

Extended Header 
Processing

Extracts the standard email extended headers, for example, 
SMTP ID, language, and so on.

Theme Classification 
Processing

Classifies the incoming message and extracts the themes.

KB Specific Search Searches the knowledge base to retrieve related response 
documents.

Entering Queue Places the message in a queue after Processing. eMC Server 
retrieves the message from this queue and processes it further.
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1.8.10.2 Creating Additional Email Workflow Processes
The following steps comprise configuring additional email workflow processes. For 
using default email workflow processes, no configuration is required.

1.8.10.2.1 Creating the Lookup Codes  

Lookup codes are used in the workflow to link the email accounts with their 
respective workflow paths or processes. eMail Center ships with a set of default 
Lookup Codes, such as Support. These lookup codes should match the email 
accounts created in the Email Server (Refer to Creating Email Server Accounts) and 
defined in the eMail Center (Refer to Defining Email Server Accounts). If the 
account name does not match the default lookup codes, follow the steps below to 
create a new lookup code.

Steps
1. Log in to Oracle Workflow Builder.

2. Select process->Mail Preproc (this selects the mail preprocessing workflow).

3. Double-click the screen.

In the Workflow Builder, Mail Preproc gets loaded.

4. From the Navigator screen of Oracle Workflow Builder, click Lookup Type.

5. Select IM User Address.

A list of default lookup codes appears.

6. Right-click IM User Address.

7. Select New Lookup Code.

The Lookup Code screen appears.

8. Enter the following data:

■ Internal Name - this is the email account name that was created in IM and 
defined in the eMail Center. For example, you can enter “Marketing” for the 
Marketing account.

Table 1–6 Non-Mandatory Workflow Node

Node Name Function

Extract Key Value This node searches the message body of an email for the 
occurrence of a character or word(s).
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■ Display Name - this is the descriptive name that appears in the lookup 
code. (The Oracle Workflow Builder recommends that the Internal Name 
and Display Name are different).

9. Click OK.

1.8.10.2.2 Configuring the Global Attributes  Use this procedure to customize the global 
attributes for unstructured workflow.

Steps
1. Log in to the Oracle Workflow Builder as Oracle Applications User.

The Show Item screen appears, displaying a list of items.

2. From the list of items in the Show Item screen, select Email Preprocessing for 
unstructured.

3. Click OK.

The Workflow Builder loads the workflow.

4. Configure the global attributes for unstructured workflow according to the 
following table.

Table 1–7 Global Attributes

Attribute Name Value

Repository Name Pre-seeded with SMS,MES.

If other repositories are required, they must be added 
here.

Application ID Application ID that loaded, and therefore owns, 
documents into Marketing applications.
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1.8.10.3 Using a Workflow Node
This topic provides a high-level overview of the steps necessary to use nodes when 
building a workflow.

Steps
1. Login to Oracle Workflow Builder.

2. Select process->Mail Preproc

3. Double-click the screen.

In the Workflow Builder, Mail Preproc gets loaded.

4. From the Workflow Builder navigator, select Function.

All available nodes appear.

5. Drag and drop the desired nodes into the Process diagram.

6. Select either TRUE or FALSE for boolean return types.

7. Repeat steps 5 and 6 until you have made all desired changes to the workflow.

8. From the Workflow Builder main menu, select Verify.

Workflow Builder checks the verification of the new workflow.

9. If the verification is successful, save the new workflow to the database.

Extended Headers Currently picking up five extended headers that come 
with a message. The headers are pre-seeded with the 
following values:

Extended Header 1: MESSAGE-ID

Extended Header 2: ORGANIZATION

Extended Header 3: MAILER

Extended Header 4: LANGUAGE

Extended Header 5: CONTENT-TYPE

These attributes are retrieved from the messages and 
passed to the eMC Server.

These values can be changed to meet user 
requirements.

Table 1–7 Global Attributes

Attribute Name Value
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1.8.10.4 Guidelines for Error Processing
Errors that occur during eMail Center processing cannot be directly returned to the 
agent, since the agent and/or caller generally does not know how to respond to the 
error (in fact, eMail Center may be a background engine with no human operator). 
You can use Oracle Workflow Builder to define the events you want to occur in case 
of an error. Use Oracle Workflow Builder to modify the default error process 
associated with the process or create your own custom error process.

The error process can include branches based on error codes, send notifications, and 
attempt to deal with the error using automated rules for resetting, retrying, or 
skipping the failed activity. Once you define your error process you can associate it 
with any activity.

1.8.11 Administering eMail Center Concurrent Processes
The eMail Center Concurrent Processes use Concurrent Manager, which is a 
component of Oracle Application Object Library, and it is responsible for 
scheduling and running various concurrent programs submitted by the user. Oracle 
eMail Center makes use of this facility to schedule and run various eMail Center 
Concurrent Processes.

eMail Center uses the Oracle Applications Standard Manager to submit batch jobs 
for processing emails. All eMail Center concurrent programs with the exception of 
the eMail Center Workflow Worker are submitted from the Standard Request 
Submission (SRS) screen. 

A concurrent process will run:

■ until the specified number of messages has been processed, then

■ wait for the specified time between workers to elapse, then

■ if there are messages present, re-start the process.

If email processing takes longer than approximated, the process will continue until 
the specified number of emails has been processed and your calculated throughput 
will be in invalidated. A batch of processes must finish before the next batch starts.

Note: Oracle does not recommend any specific number of 
concurrent processes that can be run at the same time for eMail 
Center, because the number of processes is strictly hardware 
dependent.
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Throughput Calculation
Line five from the above table shows 3 processes, processing 100 emails each, with a 
delay of 20 minutes having a throughput of 600 emails per hour.

■ Estimate the time required to process 600 messages.

In this example, 10 minutes is required to process 100 emails.

■ Do the math: 3* 100 = 300 * 2 = 600 messages per hour.

In this example, each of the four workers will need to run twice for a 
throughput of 600/hr.

■ Determine your idle time requirement per worker.

In this example, each workers processes 100 emails in approximately 10 minutes 
and must run twice. The remaining time is idle time.

1.9 Troubleshooting
This topic group describes ways of troubleshooting various problems that arise 
while installing, starting, and running Oracle eMail center. This chapter discusses 
problems in the following areas:

Emails not getting through to Inbox folder of my email account
Here is a check list of things to trace your email:

■ Check if your email has bounced because of a bad email address. Re-send the 
email to the correct email address.

■ Check if your email has reached the host machine where your Oracle Email 
Server is running. Check your system logs.

■ Check if the email has reached Oracle Email Server inbound SMTP gateway. 
Check your Oracle Email Server logs. 

■ Check if your Postman process is running and delivering messages as they 
come. Check your Oracle Email Server logs.

Emails are not getting processed. Not sure if iMT is the cause.
Check if iMT is the cause by customizing your workflow processing branch so that 
it is not calling iMT.
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Having problems creating database link from my Oracle Email Server 
database to my applications database
■ Check if you have an entry in your tnsnames.ora file for your applications 

database.

■ Check your GLOBAL_NAME and global_names parameters of your 
applications database. 

Emails are getting moved into my Retry folder
Emails get moved into the Retry folder for two reasons:

■ Oracle Email Server Postman process is unable to fire the email account rule. 
Check if your database link from Oracle Email Server database to the 
applications database exists and is usable.

■ There were API failures while processing your email. Check if your database 
links from your applications database to your Oracle Email Server database are 
created and are usable. Check if your IM_API or IM_IMT_API packages are 
invalid. 

The email metadata tokens are in my exception queues
eMail Center has two Advanced Queues in its schema. They are IEMRPP_QUEUE 
[AQ1] and IEMRP_QUEUE [AQ2]. Each of these queues has its own exception 
queue. 

If your email metadata tokens are in the AQ1 exception queue:

■ This means there were ORA errors while processing that email metadata token. 
Check your Concurrent Manager request logs for your email workflow 
concurrent requests.

■ Submit ‘Process Retry Folder’ concurrent request which will reprocess emails 
metadata tokens from your AQ1 exception queue and the Retry folder.

If your email metadata tokens are in the AQ2 exception queue:

■ This means there have been problems when eMail Center server process tried to 
dequeue messages. Check your eMail Center server logs. 

Cannot see email counts on my UWQ agent desktop.
This means your emails are not getting successfully processed through your system. 
Check the following:
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■ Emails are in the AQ1 exception queue. [First check that there are no ORA 
errors in email processing workflow]

■ Emails have moved from ‘Inbox’ to ‘Retry’ or ‘Admin’ folder. [Second check 
that there are no API errors in email processing workflow]

■ Emails are in AQ2. [Third check that email processing workflow has 
successfully completed]

■ eMail Center server log says that it has delivered email items to Oracle 
Telephony Manager. [Third check that emcserver is picking up mail media 
items.]

If the above issues do not apply, your emails should be in Oracle Telephony 
Manager’s agent queues. If your Universal Work Queue server is running, then you 
should be able to see email counts on your UWQ agent desktop.

I have uploaded some documents into MES but they are not being 
picked up.
After uploading the document you need to run the “Rebuild Help Search Index” 
concurrent request. This will refresh the related MES Knowledge Base.

Unable to start eMail Center server.
The problem can be any of the following:

■ While starting the server, if the console shows “emc_server already running,” 
you might have an instance of this process still running. Check the server log to 
see if there are any warnings or errors. If everything is clean, try restarting the 
server after one minute.

■ Make sure that you are running emcServer process using a native thread 
implementation of JRE/JDK. You can check this by looking at <your JRE/JDK 
dir>/bin/sparc directory.

■ If your console or log shows any other errors, check if your <cct>.dbc is in fact 
pointing to the right environment/database. You might also want to revisit 
your emc.bat (Window NT) or emc.sh (UNIX) to check class_path and other 
variables.

eMail Center server is running but is not picking up email metadata 
tokens from AQ2.
Make sure that you assigned resources/agents who monitor your email accounts in 
the Resource Manager, and that eMail Center Server started properly, that is, there 
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are no console or log errors. Doing this tells the system that “AGENT1 is a resource 
who will work on my support email account.” When this is done, a folder named 
AGENT1 is created under the support email account on the Oracle Email Server 
(OES).

Check the following:

■ Make sure you actually have email-tokens in AQ2. Verify this by running this 
SQL Command select count(*) from iem.iemp_queue_tbl where 
q_name = ‘IEMRP_QUEUE’ after logging in as APPS user.

■ Please make sure Oracle Telephony Manager and other interaction center 
servers are running.

■ Check that your accounts are assigned to the correct interaction center group in 
eMail Center Administration Console. Look for the “interaction server group 
id” in your emc.log and check if the email tokens in AQ2 are in fact marked for 
the same interaction server group that is being served by this specific instance 
of the eMail Center server.

■ eMail Center server has built-in functionality not to pick/deliver email tokens 
to Oracle Telephony Manager if Oracle Telephony Manager communicates that 
its agent queues are full. Check your eMail Center server logs if this is the case.

iMT Processing Errors
■ Ensure that your interMedia Text is properly installed and configured. Check 

that you are able to create sample interMedia index on a table. 

■ Ensure that your LD_LIBRARY_PATH environment variable contains 
$ORACLE_HOME/ctx/lib for the external procedure LISTNER calls.

Classification emails are not creating classifications and themes.
■ The classification account has not been created on the Oracle Email Server.

■ The classification account has not been defined in the eMail Center 
Administration Console.

Unable to launch Agent UI
■ Check that your Oracle Email Server IMAP process is running.

■ Verify that your eMail Center Administration Console is configured properly.

■ Check that you set up your IMAP server to allow agents to log in with their 
user email account without the email domain.
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■ Check your JTF default responsibility system profile.

■ Check whether the iem.base.url is pointing to the correct middle tier.

■ Check that agent folders have been created.

■ Check if you have recently applied any patches to your environment that have 
changed the apps.zip in your APPL_TOP. If this is the case, you need to bounce 
your Apache Server after bringing down all the Interaction Center Servers.

A variety of reasons may prevent you from logging on. You can use the JInitiator 
console to look at the process trail of events to determine why you were not able to 
log on.

Some of the possible problems encountered when logging on include the following.

Unable to log on to Forms Applications
■ Make sure that the Forms server and the database are up and running. 

■ Enable Jinitiator console for monitoring. If the error states ?Out of Memory?, 
clear the contents of the jcache directory. This directory is typically located in 
C:\Program Files\Oracle\JInitator\jcache.

Unable to log on to HTML Applications
■ Make sure that the Apache server is up and running. Set up user and password 

correctly. Make sure that the System Profiles have been set up correctly.

■ You forgot your password or you used an incorrect password. There is no way 
to determine your old password but your administrator can assign a new 
password.

■ Your account may not be properly configured. Your administrator can make 
required changes to your account configuration.

Emails not being processed
Make sure that the following are up and running:

■ EMC Server

■ OTM Server

■ UWQ Server

■ Concurrent Manager

■ Oracle Email Server
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Documents not being retrieved
Load documents into MES.

Template merge is incomplete
Two types of merge fields, straight-insert and query, are supported in the eMail 
CenterTemplate/Suggested Response Merge functionality. This error generally 
means that not all of the straight-insert data was available.

Email failed to reach AQ1
■ Check whether your Oracle Email Server is receiving emails.

■ Check that you have defined the email account in the eMail Center 
Administration Console. 

■ Check if the database link from Oracle Email Server to the applications database 
exists and is usable.

Email fails to reach account inbox
■ This generally means that the Oracle Email Server is not functioning properly. 

■ Check if the emails are in the Retry folder. Emails might have failed while 
processing and have been moved to the Retry folder.

Email goes to Retry folder
This means there have been API errors while processing the email. Check if your 
interMedia Text is properly installed and configured.

Customer Support/Universal Work Queue Selector responsibility is not 
displayed
Check that the user is assigned the correct responsibility. 

Unable to display UWQ desktop
Check that your Forms server and the UWQ server are running.

Agent UI does not display the Message Editor
Verify that you are running the correct version of Oracle JInitiator.
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1.10 Abbreviations 
API - Application Programming Interface

CRM - Customer Relationship Management 

eMC - Oracle Email Center 

IEM - Product code for eMail Center 

IH - Interaction History 

IMAP - Internet Messaging Access Protocol 

iMT – Oracle interMedia Text 

JMA - Java Mail API 

JTF – Java Technology Framework 

KB - Knowledge Base 

KMS - Knowledge Management Systems 

MES - Marketing Encyclopedia System 

NLS - National Language Support 

OES - Oracle Email Server 

OTM - Oracle Telephony Manager 

SMS - Solution Management System 

SMTP - Simple Mail Transport Protocol 

UWQ - Universal Work Queue 

1.11 Glossary

Terms
Agent UI - The eMail Center agent user interface

Apache - A third party web server

Applet - A Java program that runs in the Internet browser

Classification - the intent(s) of an email message.
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Classification (as eMC sees it) - categories into which incoming email messages are 
sorted.

Classification Theme Signature - collection of themes and associated scores for the 
specified classification.

Customer Care - Oracle Product

Domain - Refers to the domain name in which the email account resides

eMail Center - Oracle Product

Fulfillment - Oracle Product

interMedia Text - Oracle Product

iSupport - Oracle Product

JRE - Java Runtime Environment.

Knowledge Base - A repository of documents

Message Theme Signature - collection of themes and associated scores for an 
incoming email message.

Response Selection Theme Signature - collection of themes and associated scores 
for responses to a specified classification.

Sample Message - a cleaned up message or piece of text whose contents are directly 
related to the characteristics of the classification.

Sample Response - cleaned up response or piece of text whose contents are directly 
related to the characteristics of responses for the classification.

Score - signifies the relative importance of a particular word in a given theme, 
relates to interMedia Text processing.

Suggested Response Document - standard email response documents that are used 
to respond to customer enquiries by email

Theme - keywords or phrases extracted from the text of the message or relative 
terms selected from the knowledge base.

Theme Signature - collection of themes and their associated scores.

Unstructured email - A free form email

Work Queue - A logical queue that holds each agent’s work items
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1.12 Related Documentation and Resources
The following list of documentation serves as a reference set of documents for 
installing and implementing Oracle eMail Center:

Oracle Documentation
■ Oracle Applications Concepts, Release 11i

■ Oracle Applications Installing Oracle Applications, Release 11i

■ Oracle Applications Implementing CRM Applications, Release 11i

■ Oracle eMail Center Technical Reference Manual, Release 11i

■ Oracle eMail Center Concepts and Procedures, Release 11i

■ Oracle Telephony Manager Installation Guide, Release 11i

■ Oracle Call Center Applications Setup, Release 11i

■ Oracle CRM Foundation Components Concepts and Procedures, Release 11i

■ Oracle Email Server 5.1

■ Oracle BR100 Planning Guide

■ Oracle Fulfillment, Release 11i

■ Oracle iMarketing Concepts and Procedures, Release 11i

■ Oracle Marketing Concepts and Procedures, Release 11i

■ Oracle Marketing Encyclopedia System, Release 11i

■ Oracle Applications System Administrator’s Guide, Release 11i

■ Oracle Email Server Administration Guide

Referencing TARs and Patch Information
❏ For BUG/TAR information: 

■ Reference the Oracle BUG Database at http://bug.us.oracle.com

❏ For Patch information: 

■ Patches are available for download from ARU and/or from MetaLink or 
TCPatch. 
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